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Getting Started with the Secure Firewall
Migration Tool
• About the Secure Firewall Migration Tool, on page 1
• What’s New in the Secure Firewall Migration Tool, on page 4
• Licensing for the Secure Firewall Migration Tool, on page 9
• Platform Requirements for the Secure Firewall Migration Tool, on page 9
• Requirements and Prerequisites for the ASA Configuration File, on page 9
• Requirements and Prerequisites for Threat Defense Devices, on page 10
• ASA Configuration Support, on page 10
• Guidelines and Limitations, on page 14
• Supported Platforms for Migration, on page 18
• Supported Target Management Center for Migration, on page 20
• Supported Software Versions for Migration, on page 22
• Related Documentation, on page 22

About the Secure Firewall Migration Tool
Documentation
All the information in this book refers to the most recent version of the Secure Firewall migration tool. Follow
the instructions in Download the Secure Firewall Migration Tool from Cisco.com to download the most recent
version of the Secure Firewall migration tool.
This book covers information about the Secure Firewall migration tool, right from downloading the Secure
Firewall migration tool to completing the migration. It also provides troubleshooting tips to help you overcome
migration issues. To facilitate better understanding on the end-to-end migration process, this book provides
a sample migration procedure using Firewall 2100 series as an example target device. See Sample Migration:
ASA to Threat Defense 2100 .
The Secure Firewall Migration Tool
The Secure Firewall migration tool converts the supported ASA configuration to a supported threat defense
platform. With the Secure Firewall migration tool, you can automate the migration of supported ASA features
and policies. You may have to manually migrate the unsupported features.
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The Secure Firewall migration tool gathers the ASA information, parses it, and finally pushes it to the Secure
Firewall Management Center. During the parsing phase, the Secure Firewall migration tool generates a
Pre-Migration Report that identifies the following:
• Cisco Adaptive Security Appliance (ASA) configuration items that are fully migrated, partially migrated,
unsupported for migration, and ignored for migration.
• ASA configuration lines with errors, lists the ASA CLIs that the Secure Firewall migration tool cannot
recognize; this blocks migration.
If there are parsing errors, you can rectify the issues, reupload a new configuration, connect to the destination
device, map the ASA interfaces to threat defense interfaces, map security zones and interface groups, and
proceed to review and validate your configuration. You can then migrate the configuration to the destination
device.
Console
The console opens when you launch the Secure Firewall migration tool. The console provides detailed
information about the progress of each step in the Secure Firewall migration tool. The contents of the console
are also written to the Secure Firewall migration tool log file.
The console must stay open while the Secure Firewall migration tool is open and running.

Important

When you exit the Secure Firewall migration tool by closing the browser on which the web interface is
running, the console continues to run in the background. To completely exit the Secure Firewall migration
tool, exit the console by pressing the Command key + C on the keyboard.

Logs
The Secure Firewall migration tool creates a log of each migration. The logs include details of what occurs
at each step of the migration and can help you determine the cause if a migration fails.
You can find the log files for the Secure Firewall migration tool in the following location:
<migration_tool_folder>\logs
Resources
The Secure Firewall migration tool saves a copy of the Pre-Migration Reports, Post-Migration Reports,
ASA configs, and logs in the resources folder.
You can find the resources folder in the following location:
<migration_tool_folder>\resources
Unparsed File
You can find the unparsed file in the following location: <migration_tool_folder>\resources
Search in the Secure Firewall Migration Tool
You can search for items in the tables that are displayed in the Secure Firewall migration tool, such as those
on the Optimize, Review and Validate page.
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To search for an item in any column or row of the table, click the Search ( ) above the table and enter the
search term in the field. The Secure Firewall migration tool filters the table rows and displays only those that
contain the search term.
To search for an item in a single column, enter the search term in the Search field that is provided in the
column heading. The Secure Firewall migration tool filters the table rows and displays only those that match
the search term.
Ports
The Secure Firewall migration tool supports telemetry when run on one of these 12 ports: ports 8321-8331
and port 8888. By default, Secure Firewall migration tool uses port 8888. To change the port, update port
information in the app_config file. After updating, ensure to relaunch the Secure Firewall migration tool
for the port change to take effect. You can find the app_config file in the following location:
<migration_tool_folder>\app_config.txt.

Note

We recommend that you use ports 8321-8331 and port 8888, as telemetry is only supported on these
ports. If you enable Cisco Success Network, you cannot use any other port for the Secure Firewall
migration tool.

Cisco Success Network
Cisco Success Network is user-enabled cloud service. When you enable Cisco Success Network, a secure
connection is established between the Secure Firewall migration tool and the Cisco cloud to stream usage
information and statistics. Streaming telemetry provides a mechanism to select data of interest from the Secure
Firewall migration tool and to transmit it in structured format to remote management stations for the following
benefits:
• To inform you of available unused features that can improve the effectiveness of the product in your
network.
• To inform you of more technical support services and monitoring that is available for your product.
• To help Cisco improve our products.
The Secure Firewall migration tool establishes and maintains the secure connection always and allows you
to enroll in the Cisco Success Network. You can turn off this connection at any time by disabling Cisco
Success Network, which disconnects the device from the Cisco Success Network cloud.
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What’s New in the Secure Firewall Migration Tool
Version

Supported Features

3.0.1

Secure Firewall migration tool 3.0.1 supports:
• Migration of Enhanced Interior Gateway Routing Protocol (EIGRP) from ASA
if the destination management center is version 7.2 and later and the threat
defense version is 7.0 and later.
Note

You cannot migrate EIGRP from ASA without a threat defense
device.

• The Cisco Secure Firewall 3100 series is supported as a source or destination
device for ASA migrations.
3.0

The Secure Firewall migration tool 3.0 now supports:
• Remote Access VPN migration from ASA if the destination management center
is 7.2 or later. You can perform RA VPN migration with or without Secure
Firewall Threat Defense. If you select the migration with threat defense, then
the threat defense version must be 7.0 or later.
• Site-to-Site VPN pre-shared key automation from ASA .
• The following must be performed as part of the pre-migration activity:
• The ASA trustpoints must be manually migrated to the management center
as PKI objects.
• AnyConnect packages, Hostscan Files (Dap.xml, Data.xml, Hostscan
Package), External Browser package, and AnyConnect profiles must be
retrieved from source ASA.
• AnyConnect packages must be uploaded to the management center.
• AnyConnect profiles must be directly uploaded to the management center
or from the Secure Firewall migration tool.
• The ssh scopy enable command must be enabled on the ASA to allow
retrieval of profiles from the Live Connect ASA.
• Migration to Cloud-delivered Firewall Management Center from ASA if the
destination management center is 7.2 or later.
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Version

Supported Features

2.5.2

The Secure Firewall migration tool 2.5.2 now provides support to identify and
segregate ACLs that can be optimized (disabled or deleted) from the firewall rule
base without impacting the network functionality from Firewalls.
The ACL Optimization supports the following ACL types:
• Redundant ACL—When two ACLs have the same set of configurations and
rules, then removing the non-base ACL will not impact the network.
• Shadow ACL—The first ACL completely shadows the configurations of the
second ACL.
Note

Optimization is available for the ASA only for ACP rule action.

The Secure Firewall migration tool 2.5.2 supports Border Gateway Protocol (BGP)
and Dynamic-Route Objects migration if the destination management center is 7.1
or later.
2.5.1

The Secure Firewall migration tool 2.5.1 supports Border Gateway Protocol (BGP)
and Dynamic-Route Objects migration if the destination management center is 7.1
or later.

2.5

The Secure Firewall migration tool 2.5 now provides support to identify and
segregate ACLs that can be optimized (disabled or deleted) from the firewall rule
base without impacting the network functionality.
The ACL Optimization supports the following ACL types:
• Redundant ACL—When two ACLs have the same set of configurations and
rules, then removing the non-base ACL will not impact the network.
• Shadow ACL—The first ACL completely shadows the configurations of the
second ACL.
Note

Optimization is available for the Source ASA only for ACP rule action.

Support for discontinuous network mask (Wildcard mask) objects if the destination
management center is 7.1 or later.
2.4

The following ASA VPN configuration migration to threat defense:
• Crypto map (static/dynamic) based VPN from ASA
• Route-based (VTI) based ASA VPN
• Certificate-based VPN migration from ASA
Note

• ASA trustpoint or certificates is migrated manually and part of
pre-migration activity.
• ASA trustpoint must be migrated as management center PKI objects.
PKI objects are used in Secure Firewall migration tool while creating
certificate-based VPN topologies.
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Version

Supported Features

2.3.5

The Secure Firewall migration tool supports the migration of the following Virtual
Tunnel Interface (VTI) configurations to threat defense if the target management
center and threat defense is 6.7 or later:
• VTI interface and the related static routes
• Route-based (VTI) pre-shared key authentication type VPN configuration to
management center and threat defense.
• Create routed security zone, add VTI interfaces, and then define access control
rules for the decrypted traffic control over VTI tunnel.

2.3.4

The Secure Firewall migration tool allows you to migrate the following ASA VPN
configuration elements to threat defense:
• Supports migration of policy-based (crypto map) pre-shared key authentication
type VPN configuration to the management center.
• VPN Objects—Creates VPN Objects (IKEv1/IKEv2 Policy, IKEv1/IKEv2
IPsec-Proposal), maps the VPN objects with the specific Site-to-Site VPN
topologies, and migrates the objects to the management center.
Verify the VPN objects against the rules in the Review and Validate
Configuration page.
• Site-to-Site VPN Topology—The crypto map related configurations in source
ASA config are migrated with respective VPN objects. Policy-based (crypto
map) VPN Topology are supported on management center version 6.6 and
above.
Note

In this release, Secure Firewall migration tool supports migration
of static crypto map only.
All supported ASA crypto map VPN will be migrated as
management center point-to-point topology.
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Version
1.3

Supported Features
• The Secure Firewall migration tool allows you to connect to an ASA using the
admin credentials and Enable Password as configured on the ASA.
If ASA is not configured with Enable Password, you can leave the field blank
on the Secure Firewall migration tool.
• You can now configure the batch size limit for Bulk Push in the app_config
file as follows:
• For Objects, the batch size cannot exceed 500. The Secure Firewall
migration tool resets the value to 50 and proceeds with the bulk push.
• For ACLs, Routes, and NAT, the batch size cannot exceed 1000 each.
The Secure Firewall migration tool resets the value to 1000 and proceeds
with the bulk push.
• The Secure Firewall migration tool allows you to parse the CSM or ASDM
managed configurations.
When you opt to clear the inline grouping or ASDM managed configurations,
the predefined objects are replaced with the actual object or member name.
If you do not clear the CSM or ASDM managed configurations, the predefined
object names will be retained for migration.
• Provides customer support to download log files, dB, and configuration files
during a migration failure. You can also raise a support case with the technical
team through an email.
• Support for migration of IPv6 configurations in Objects, Interfaces, ACL,
NAT, and Routes.
• The Secure Firewall migration tooll allows you to map an ASA interface name
to a physical interface on the threat defense object types—Physical interfaces,
port channel, and subinterfaces. For example, you can map a port channel in
ASA to a physical interface in management center.
• The Secure Firewall migration tool provides support to skip migration of the
selected NAT rules and Route interfaces. The previous versions of the Secure
Firewall migration tool provided this option for Access Control rules only.
• You can download the parsed Access Control, NAT, Network Objects, Port
Objects, Interface, and Routes configuration items from the Optimize, Review
and Validate Configuration screen in an excel or CSV format.
Note

You cannot import a CSV file.
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Version
1.2

Supported Features
• Supports migration to management center 6.3
• Supports migration of IPv4 FQDN Objects and Groups
• Supports the show tech-support command in the manual upload method for
Multiple-Context ASA
• Supports migration to the container type threat defense (MI) registered on
management center.
• Rule Action Mapping Support (Allow, Trust, Monitor, Block, or Block with
Reset) on the migrated access control rules in the Access Control table.
• Version check for Secure Firewall migration tool to ensure that you are using
the most recent version of the Secure Firewall migration tool.

1.1

• Bulk push for objects, NAT, static routes significantly reduce the time that is
taken to push the configuration to a management center.
• Extracting configuration from a production ASA
• Selective feature migration (shared policy and device-specific policy)
• Rule optimization
• Map migrating ASA Access Control Rules to a list of configured Intrusion
Prevention System and File Policies on the management center.
• Migrate only those objects that are referenced in policies. This optimizes
migration times and cleans out unused objects during configuration.
• Migration support for running-config or sh run from one of Data Contexts
of ASA running in multiple-context mode.
• Support on macOS version 10.13 and higher
• Support to modify logging actions (enable or disable, logging at beginning or
end) for migrated Access Control Rules.
• Migration to threat defense devices configured within domains on the
management center.
• Bulk edits capability for object names.
• Telemetry support with Cisco Success Network
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Version
1.0

Supported Features
• Validation throughout the migration, including parse and push operations.
• Object re-use capability
• Object conflict resolution
• Interface mapping
• Autocreation or reuse of interface objects (ASA name if to the security zone
and interface group mapping)
• Support for a bulk migration of ACLs

Licensing for the Secure Firewall Migration Tool
The Secure Firewall migration tool application is free and does not require license. However, the management
center must have the required licenses for the related threat defense features for successfully registering the
threat defense and deploying policies to it.

Platform Requirements for the Secure Firewall Migration Tool
The Secure Firewall migration tool has the following infrastructure and platform requirements:
• Runs on a Windows 10 64-bit operating system or on a macOS version 10.13 or higher
• Has Google Chrome as the system default browser
• (Windows) Has Sleep settings configured in Power & Sleep to Never put the PC to Sleep, so the system
does not go to sleep during a large migration push
• (macOS) Has Energy Saver settings configured so that the computer and the hard disk do not go to sleep
during a large migration push

Requirements and Prerequisites for the ASA Configuration File
You can obtain an ASA configuration file either manually or by connecting to a live ASA from the Secure
Firewall migration tool.
The ASA configuration file that you manually import into the Secure Firewall migration tool must meet the
following requirements:
• Has a running configuration that is exported from an ASA device in a single mode configuration or
specific context of a multiple context mode configuration. See Export the ASA Configuration File, on
page 28.
• Includes the version number.
• Contains only valid ASA CLI configurations.
• Does not contain syntax errors.
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• Has a file extension of .cfg or .txt.
• Uses a file encoding of UTF-8.
• Has not been hand coded or manually altered. If you modify the ASA configuration, we recommend that
you test the modified configuration file on the ASA device to ensure that it is a valid configuration.
• Does not contain the "--More--" keyword as text.

Requirements and Prerequisites for Threat Defense Devices
When you migrate to the management center, it may or may not have a target threat defense device added to
it. You can migrate shared policies to a management center for future deployment to a threat defense device.
To migrate device-specific policies to a threat defense, you must add it to the management center. As you
plan to migrate your ASA configuration to threat defense, consider the following requirements and prerequisites:
• The target threat defense device must be registered with the management center.
• The threat defense device can be a standalone device or a container instance. It must not be part of a
cluster or a high availability configuration.
• The target native threat defense device must have at least an equal number of used physical data
and port channel interfaces (excluding ‘management-only’ and subinterfaces) as that of the ASA;
if not you must add the required type of interface on the target threat defense device. Subinterfaces
are created by the Secure Firewall migration tool that are based on physical or port channel mapping.
• If the target threat defense device is a container instance, at minimum it must have an equal number
of used physical interfaces, physical subinterfaces, port channel interfaces, and port channel
subinterfaces (excluding ‘management-only’) as that of the ASA; if not you must add the required
type of interface on the target threat defense device

Note

• Subinterfaces are not created by the Secure Firewall migration tool,
only interface mapping is allowed
• Mapping across different interface types is allowed, for example:
physical interface can be mapped to a port channel interface.

ASA Configuration Support
Supported ASA Configurations
The Secure Firewall migration tool can fully migrate the following ASA configurations:
• Network objects and groups
• Service objects, except for those service objects configured for a source and destination
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Note

Though the Secure Firewall migration tool does not migrate extended service
objects (configured for a source and destination), referenced ACL and NAT
rules are migrated with full functionality.

• Service object groups, except for nested service object groups

Note

Since nesting is not supported on the management center, the Secure Firewall
migration tool expands the content of the referenced rules. The rules
however, are migrated with full functionality.

• IPv4 and IPv6 FQDN objects and groups
• IPv6 conversion support (Interface, Static Routes, Objects, ACL, and NAT)
• Access rules that are applied to interfaces in the inbound direction and global ACL
• Auto NAT, Manual NAT, and object NAT (conditional)
• Static routes, ECMP routes which are not migrated
• Physical interfaces
• Secondary VLANs on ASA interfaces will not migrate to threat defense.
• Subinterfaces (subinterface ID will always be set to the same number as the VLAN ID on migration)
• Port channels
• Virtual tunnel interface (VTI)
• Bridge groups (transparent mode only)
• IP SLA Monitor
The Secure Firewall migration tool creates IP SLA Objects, maps the objects with the specific static
routes, and migrates the objects to management center.
IP SLA monitor defines a connectivity policy to a monitored IP address and tracks the availability of a
route to the IP address. The static routes are periodically checked for availability by sending ICMP echo
requests and waiting for the response. If the echo requests are timed-out, the static routes are removed
from the routing table and replaced with a backup route. SLA monitoring jobs start immediately after
deployment and continue to run unless, you remove the SLA monitor from the device configuration, that
is, they do not ageout. The IP SLA monitor objects are used in the Route Tracking field of an IPv4 static
route policy. IPv6 routes do not have the option to use SLA monitor through route tracking.

Note

IP SLA Monitor is not supported for non-threat defense flow.

• Object Group Search
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Enabling object group search reduces memory requirements for access control policies that include
network objects. We recommend you to enable object group search that enhances optimal memory
utilization by access policy on threat defense.

Note

• Object Group Search is unavailable for management center or threat
defense version earlier than 6.6.
• Object Group Search will not be supported for non-threat defense flow
and will be disabled.

• Time-based objects
When the Secure Firewall migration tool detects Time-based objects that are referenced with access-rules,
the Secure Firewall migration tool migrates the Time-based objects and maps them with respective
access-rules. Verify the objects against the rules in the Review and Validate Configuration page.
Time-based objects are access-list types that allow network access on the basis of time period. It is useful
when you must place restrictions on outbound or inbound traffic on the basis of a particular time of the
day or particular days of a week.

Note

• You must manually migrate timezone configuration from source ASA
to target FTD.
• Time-based object is not supported for non-threat defense flow and
will be disabled.
• Time-based objects are supported on management center version 6.6
and above.

• Site-to-Site VPN Tunnels
• Site-to-Site VPN—When the Secure Firewall migration tool detects crypto map configuration in
the source ASA, the Secure Firewall migration tool migrates the crypto map to the management
center VPN as point-to-point topology.
• Crypto map (static/dynamic) based VPN from ASA
• Route-based (VTI) ASA VPN
• Certificate-based VPN migration from ASA
• ASA trustpoint or certificates migration to the management center must be performed manually and
is part of the pre-migration activity.
• Dynamic-Route Objects, BGP, and EIGRP
• Policy-List
• Prefix-List
• Community List
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• Autonomous System (AS)-Path
• Remote Access VPN
• SSL and IKEv2 protocol.
• Authentication methods—AAA only, Client Certificate only, SAML, AAA, and Client Certificate.
• AAA—Radius, Local, LDAP, and AD.
• Connection Profiles, Group-Policy, Dynamic Access Policy, LDAP Attribute Map, and Certificate
Map.
• Standard and Extended ACL.
• As part of pre-migration activity, perform the following:
• Migrate the ASA trustpoints manually to the management center as PKI objects.
• Retrieve AnyConnect packages, Hostscan Files (Dap.xml, Data.xml, Hostscan Package),
External Browser package, and AnyConnect profiles from the source ASA.
• Upload all AnyConnect packages to the management center.
• Upload AnyConnect profiles directly to the management center or from the Secure Firewall
migration tool.
• Enable the ssh scopy enable command on the ASA to allow retrieval of profiles from the Live
Connect ASA.

Partially Supported ASA Configurations
The Secure Firewall migration tool partially supports the following ASA configurations for migration. Some
of these configurations include rules with advanced options that are migrated without those options. If the
management center supports those advanced options, you can configure them manually after the migration is
complete.
• Access control policy rules that are configured with advanced logging settings, such as severity and
time-interval.
• Static routes that are configured with the track option.
• Certificate-based VPN migration.
• Dynamic-Route Objects, EIGRP, and BGP
• Route-Map

Unsupported ASA Configurations
The Secure Firewall migration tool does not support the following ASA configurations for migration. If these
configurations are supported in the management center, you can configure them manually after the migration
is complete.
• SGT-based access control policy rules
• SGT-based objects
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• User-based access control policy rules
• NAT rules that are configured with the block allocation option
• Objects with an unsupported ICMP type and code
• Tunneling protocol-based access control policy rules

Note

Support with a prefilter on Secure Firewall migration tool and management
center 6.5.

• NAT rules that are configured with SCTP
• NAT rules that are configured with host ‘0.0.0.0’
• Default route obtained through DHCP or PPPoE with SLA tracking
• SLA monitor schedule
• Transport mode IPsec transform-set
• ASA trustpoint migration into management center
• Transparent firewall mode for BGP

Guidelines and Limitations
During conversion, the Secure Firewall migration tool creates a one-to-one mapping for all supported objects
and rules, whether they are used in a rule or policy. The Secure Firewall migration tool provides an optimization
feature that allows you to exclude migration of unused objects (objects that are not referenced in any ACLs
and NATs).
The Secure Firewall migration tool deals with unsupported objects and rules as follows:
• Unsupported objects and NAT rules are not migrated.
• Unsupported ACL rules are migrated as disabled rules into the management center.
• Outbound ACLs are unsupported and will not be migrated to management center. If the source firewall
has outbound ACLs, it will be reported in the ignored section of the Pre-Migration Report.
• All supported ASA crypto map VPN will be migrated as management center point-to-point topology.
• Unsupported or incomplete static crypto map VPN topologies are not migrated.
ASA Configuration Limitations
Migration of your source ASA configuration has the following limitations:
• The Secure Firewall migration tool supports migrating individual security contexts from the ASA as
separate threat defense devices.
• The system configuration is not migrated.
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• The Secure Firewall migration tool does not support migration of a single ACL policy that is applied to
over 50 interfaces. Manually migrate ACL policies that are applied to 50 or more interfaces.
• You cannot migrate some ASA configurations, for example, dynamic routing to threat defense. Migrate
these configurations manually.
• You cannot migrate ASA devices in routed mode with a bridge virtual interface (BVI), redundant interface,
or tunneled interface. However, you can migrate ASA devices in transparent mode with BVI.
• Nested service object-groups or port groups are not supported on the management center. As part of
conversion, the Secure Firewall migration tool expands the content of the referenced nested object-group
or port group.
• The Secure Firewall migration tool splits the extended service object or groups with source and destination
ports that are in one line into different objects across multiple lines. References to such access control
rules are converted into management center rules with the exact same meaning.
• If the source ASA configuration has access control rules that do not refer to specific tunneling protocols
(like GRE, IP-in-IP and IPv6-in-IP), but these rules match unencrypted tunnel traffic on the ASA, then,
on migration to the threat defense, the corresponding rules will not behave in the same way they do on
the ASA. We recommend that you create specific tunnel rules for these in the Prefilter policy, on the
threat defense.
• Supported ASA crypto map will be migrated as point-to-point topology.
• If an AS-Path object with the same name in management center appears, then the migration stops with
the following error message:
"Conflicting AS-Path object name detected in management center, please resolve conflict in management
center to proceed further"
• Redistribution from OSPF and Routing Information Protocol (RIP) into EIGRP is not supported.
Limitations for RA VPN Migration
Remote Access VPN migration is supported with the following limitations:
• Custom attributes, SSL settings and VPN load balancing migration is not supported due to API limitations.
• LDAP server is migrated with encryption type as "none".
• DfltGrpPolicy is not migrated as the policy is applicable for the entire management center. You can make
the necessary changes directly on the management center.
• For a radius server, if dynamic authorization is enabled, the AAA server connectivity should be through
an interface and not dynamic routing. If ASA configuration is found with AAA server with dynamic
authorization enabled without interface, the Secure Firewall migration tool ignores dynamic authorization.
You must enable dynamic-authorization manually after selecting an interface on the management center.
• ASA configuration can have an interface while calling address pool under tunnel-group. But, the same
is not supported on the management center. If there is an interface detected in ASA configuration it will
be ignored by the Secure Firewall migration tool and address pool is migrated without the interface.
• ASA configuration can have keyword link-selection/subnet-selection for dhcp-server under tunnel
group. But, the same is not supported on the management center. If there is a dhcp server detected in
ASA configuration with these keywords, it will be ignored by the Secure Firewall migration tool and
dhcp-server is pushed without the keywords.
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• ASA configuration can have an interface while calling authentication server group, secondary
authentication server group, authorization server group under tunnel group. But the same is not supported
on the management center. If there is an interface detected in ASA configuration it will be ignored by
the Secure Firewall migration tool and commands are pushed without the interface.
• ASA configuration does not map Redirect ACL to a radius server. Thus, there is no way to retrieve it
from the Secure Firewall migration tool. If redirect ACL is used in ASA, it will be left empty and you
must add and map it manually on the management center.
• ASA supports value from 0-720 for vpn-addr-assign local reuse delay. But, management center supports
value from 0-480. If a value higher than 480 is found in the ASA configuration, it is set to maximum
supported value 480 on the management center.
• Configuring IPv4 pool and DHCP useSecondaryUsernameforSession settings to the connection profile
is not supported due to API issues.
• Bypass access control sysopt permit-vpn option is not enabled under RA VPN policy. However, if
required, you can enable it from the management center.
• AnyConnect client module and profile values can be updated under group policy only when the profiles
are uploaded from Secure Firewall migration tool to the management center.
• You need to map the certificates directly on the management center.
• IKEv2 parameters are not migrated by default. You must add them through the management center.
ASA Migration Guidelines
The migration of the ACL log option follows the best practices for threat defense. The log option for a rule
is enabled or disabled based on the source ASA configuration. For rules with an action of deny, the Secure
Firewall migration tool configures logging at the beginning of the connection. If the action is permit, the
Secure Firewall migration tool configures logging at the end of the connection.
Object Migration Guidelines
ASA and threat defense have different configuration guidelines for objects. For example, one or more objects
can have the same name in ASA with one object name in lowercase and the other object name in uppercase,
but each object must have a unique name, regardless of case, in threat defense. To accommodate such
differences, the Secure Firewall migration tool analyzes all ASA objects and handles their migration in one
of the following ways:
• Each ASA object has a unique name and configuration—The Secure Firewall migration tool migrates
the objects successfully without changes.
• The name of an ASA object includes one or more special characters that are not supported by the
management center—The Secure Firewall migration tool renames the special characters in the object
name with a "_" character to meet the Management Center object naming criteria.
• An ASA object has the same name and configuration as an existing object in the management center—The
Secure Firewall migration tool reuses the Secure Firewall Management Center object for the Secure
Firewall Threat Defense configuration and does not migrate the ASA object.
• An ASA object has the same name but a different configuration than an existing object in Secure Firewall
Management Center—The Secure Firewall migration tool reports object conflict and allows you to resolve
the conflict by adding a unique suffix to the name of the ASA object for migration purposes.
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• Multiple ASA objects have the same name but in different cases—The Secure Firewall migration tool
renames such objects to meet the Secure Firewall Threat Defense object naming criteria.

Note

The Secure Firewall migration tool supports discontiguous network mask (Wildcard mask) objects
migration if the destination Firewall Management Center is 7.1 or later.

ASA example:
object network wildcard2
subnet 2.0.0.2 255.0.0.255

Guidelines and Limitations for Threat Defense Devices
As you plan to migrate your ASA configuration to threat defense, consider the following guidelines and
limitations:
• If there are any existing device-specific configurations on the threat defense such as routes, interfaces,
and so on, during the push migration, the Secure Firewall migration tool cleans the device automatically
and overwrites from the ASA configuration.

Note

To prevent any undesirable loss of device (target threat defense)
configuration data, we recommend you to manually clean the device before
migration.

During migration, the Secure Firewall migration tool resets the interface configuration. If you use these
interfaces in policies, the Secure Firewall migration tool cannot reset them and hence the migration fails.
• The Secure Firewall migration tool can create subinterfaces on the native instance of the threat defense
device based on the ASA configuration. Manually create interfaces and port channel interfaces on the
target threat defense device before starting migration. For example, if your ASA configuration is assigned
with the following interfaces and port channels, you must create them on the target threat defense device
before the migration:
• Five physical interfaces
• Five port channels
• Two management-only interfaces

Note

For container instances of threat defense devices, subinterfaces are not
created by the Secure Firewall migration tool, only interface mapping is
allowed.

• The Secure Firewall migration tool can create subinterfaces and Bridge-Group Virtual Interfaces
(transparent mode) on the native instance of the threat defense device that is based on the ASA
configuration. Manually create interfaces and port channel interfaces on the target threat defense device
before starting migration. For example, if your ASA configuration is assigned with the following interfaces
and port channels, you must create them on the target threat defense device before the migration:
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• Five physical interfaces
• Five port channels
• Two management-only interfaces

Note

For container instances of threat defense devices, subinterfaces are not
created by the Secure Firewall migration tool, only interface mapping is
allowed.

Supported Platforms for Migration
The following ASA and threat defense platforms are supported for migration with the Secure Firewall migration
tool. For more information about the supported threat defense platforms, see Cisco Secure Firewall
Compatibility Guide.

Note

The Secure Firewall migration tool supports migration of standalone ASA devices to a standalone threat
defense device only.

Supported Source ASA Platforms
You can use the Secure Firewall migration tool to migrate the configuration from the following single or
multi-context ASA platforms:
• ASA 5510
• ASA 5520
• ASA 5540
• ASA 5550
• ASA 5580
• ASA 5506
• ASA 5506W-X
• ASA 5506H-X
• ASA 5508-X
• ASA 5512-X
• ASA 5515-X
• ASA 5516-X
• ASA 5525-X
• ASA 5545-X
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• ASA 5555-X
• ASA 5585-X with ASA only (the Secure Firewall migration tool does not migrate the configuration from
the) ASA FirePOWER module
• Firepower 1000 Series
• Firepower 2100 Series
• Secure Firewall 3100 Series
• Firepower 4100 Series
• Firepower 9300 Series
• SM-24
• SM-36
• SM-40
• SM-44
• SM-48
• SM-56
• ASA Virtual on VMware, deployed using VMware ESXi, VMware vSphere Web Client, or vSphere
standalone client
Supported Target Threat Defense Platforms
You can use the Secure Firewall migration tool to migrate a source ASA configuration to the following
standalone or container instance of the threat defense platforms:
• ASA 5506
• ASA 5506W-X
• ASA 5506H-X
• ASA 5508-X
• ASA 5512-X
• ASA 5515-X
• ASA 5516-X
• ASA 5525-X
• ASA 5545-X
• ASA 5555-X
• Firepower 1000 Series
• Firepower 2100 Series
• Secure Firewall 3100 Series
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• Firepower 4100 Series
• Firepower 9300 Series that includes:
• SM-24
• SM-36
• SM-40
• SM-44
• SM-48
• SM-56
• Threat Defense on VMware, deployed using VMware ESXi, VMware vSphere Web Client, or vSphere
standalone client
The Secure Firewall migration tool supports migration to threat defense virtual for Microsoft Azure Cloud.
For pre-requisites and pre-staging of threat defense virtual in Azure, see Getting Started with Secure Firewall
Threat Defense Virtual and Azure.
The Secure Firewall migration tool supports migration to threat defense virtual for the AWS Cloud.
For pre-requisites and pre-staging of threat defense virtual in AWS Cloud, see Threat Defense Virtual
Prerequisites.
For each of these environments, once pre-staged as per the requirements, the Secure Firewall migration tool
requires network connectivity to connect to the management center in Microsoft Azure or AWS Cloud, and
then migrate the configuration to the management center in the Cloud.

Note

The pre-requisites of pre-staging the management center or threat defense virtual is required to be
completed before using the Secure Firewall migration tool, to have a successful migration.

Note

The Secure Firewall migration tool requires network connectivity to any devices hosted in the cloud to
either extract the source configuration (ASA Live Connect) or migrate the manually uploaded
configuration to the management center in the cloud. Hence, as a pre-requisite, IP network connectivity
is required to be pre-staged before using the Secure Firewall migration tool.

Supported Target Management Center for Migration
The Secure Firewall migration tool supports migration to threat defense devices managed by the management
center and cloud-delivered Firewall Management Center.
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Management Center
The management center is a powerful, web-based, multi-device manager that runs on its own server hardware,
or as a virtual device on a hypervisor. You can use both On-Prem and Virtual management center as a target
management center for migration.
The management center should meet the following guidelines for migration:
• The Management Center software version that is supported for migration, as described in Supported
Software Versions for Migration, on page 22.
• You have obtained and installed smart licenses for threat defense that include all features that you plan
to migrate from the ASA interface, as described in the following:
• The Getting Started section of Cisco Smart Accounts on Cisco.com.
• Register the Firewall Management Center with the Cisco Smart Software Manager.
• Licensing the Firewall System
• You have enabled management center for REST API.

Tip

On the management center web interface, navigate to. System >
Configuration > Rest API Preferences > Enable Rest API and check the
Enable Rest API check box.
• You have created a dedicated user with REST API privileges in management center for the Secure
Firewall migration tool, as described in User Accounts for Management Access.

Cloud-Delivered Firewall Management Center
The cloud-delivered Firewall Management Center is a management platform for threat defense devices and
is delivered via Cisco Defense Orchestrator. The cloud-delivered Firewall Management Center offers many
of the same functions as a management center.
You can access the cloud-delivered Firewall Management Center from CDO. CDO connects to cloud-delivered
Firewall Management Center through the Secure Device Connector (SDC). For more information about
cloud-delivered Firewall Management Center, see Managing Cisco Secure Firewall Threat Defense Devices
with Cloud-Delivered Firewall Management Center.
The Secure Firewall migration tool supports cloud-delivered Firewall Management Center as a destination
management center for migration. To select the cloud-delivered Firewall Management Center as destination
management center for migration, youneed to add the CDO region and generate the API token from CDO
portal.
CDO Regions
CDO is available in three different regions and the regions can be identified with the URL extension.
Table 1: CDO Regions and URL

Region

CDO URL

Europe Region

https://defenseorchestrator.eu/
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Region

CDO URL

US Region

https://defenseorchestrator.com/

APJC Region

https://www.apj.cdo.cisco.com/

Supported Software Versions for Migration
The following are the supported ASA and threat defense versions for migration:
Supported ASA Versions
The Secure Firewall migration tool supports migration from a device that is running ASA software version
8.4 and later.
Supported Management Center Versions for source ASA Configuration
For ASA, the Secure Firewall migration tool supports migration to a threat defense device managed by a
management center that is running version 6.2.3 or 6.2.3+.

Note

Some features are supported only in the later versions of management center and threat defense.

Note

For optimum migration times, We recommend that you upgrade management center to the suggested
release version provided here: software.cisco.com/downloads.

Supported Threat Defense Versions
The Secure Firewall migration tool recommends migration to a device that is running threat defense version
6.5 and later.
For detailed information about the Cisco Firewall software and hardware compatibility, including operating
system and hosting environment requirements, for threat defense, see the Cisco Firewall Compatibility Guide.

Related Documentation
This section summarizes the Firewall Migration Tool related documentation.
• Migrating Certificates from ASA to Firepower Threat Defense—Describes the procedure to migrate
Identity (ID) and Certificate Authority (CA) Certificates from Cisco ASA to a Secure Firewall Threat
Defense device.
• Migrating ASA to Firepower Threat Defense Site-to-Site VPN Using IKEv1 with Certificates—Describes
the procedure to migrate site-to-site IKEv1 VPN tunnels, using certificates (rsa-sig) as a method of
authentication, from the existing Cisco ASA to threat defense, managed by management center.

Migrating Secure Firewall ASA to Threat Defense with the Migration Tool
22

Getting Started with the Secure Firewall Migration Tool
Related Documentation

• Migrating ASA to Firepower Threat Defense Site-to-Site VPN Using IKEv2 with Certificates—Describes
the procedure to migrate site-to-site IKEv2 VPN tunnels, using certificates (rsa-sig) as a method of
authentication, from the existing ASA to threat defense, managed by management center.
• Migrating ASA to Firepower Threat Defense Dynamic Crypto Map Based Site-to-Site Tunnel on
FTD—Describes the procedure to migrate a Dynamic Crypto Map based site-to-site VPN tunnels (with
IKEv1 or IKEv2), using pre-shared key and certificate as a method of authentication, from the existing
ASA to threat defense, managed by management center.
• Migrating ASA to Firepower Threat Defense Site-to-Site VPN Using IKEv1 with Pre-Shared Key
Authentication—Describes the procedure to migrate Site-to-Site IKEv1 VPN tunnels, using pre-shared
key (PSK) as a method of authentication, from the existing ASA to threat defense, managed by
management center.
• Migrating ASA to Firepower Threat Defense Site-to-Site VPN Using IKEv2 with Pre-Shared Key
Authentication—Describes the procedure to migrate site-to-site IKEv2 VPN tunnels, using pre-shared
key (PSK) as a method of authentication, from the existing ASA to threat defense, managed by
management center.
• Migrating ASA to Firepower Threat Defense Platform Settings—Describes the steps to migrate the
platform setting configuration of ASA to threat defense devices.
• Cisco ASA FirePOWER Module Quick Start Guide—Describes how the ASA FirePOWER Module
Works with the ASA.
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ASA to Threat Defense Migration Workflow
• End-to-End Procedure, on page 25
• Prepare For Migration, on page 27
• Run the Migration, on page 30
• Uninstall the Secure Firewall Migration Tool, on page 56
• Sample Migration: ASA to Threat Defense 2100 , on page 56

End-to-End Procedure
The following flowchart illustrates the workflow for migrating an ASA to threat defense using the Secure
Firewall migration tool.

Workspace

Steps

Local Machine

Download the latest version of Secure Firewall migration tool from Cisco.com.
For detailed steps, see Download the Secure Firewall Migration Tool from
Cisco.com.
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Workspace

Steps

ASA CLI

(Optional) Obtain the ASA configuration file: To obtain the ASA config file
from ASA CLI, see Obtain the ASA Configuration File. If you intend to
connect the ASA from Secure Firewall migration tool, skip to step 3.

ASA CLI

(Optional) Export PKI certificates from ASA CLI: This step is required only
if you are planning to migrate site-to site VPN and RA VPN features from
ASA to threat defense. To export the PKI certificates from ASA CLI, see
Export PKI Certificate from ASA and Import into Management Center. If
you are not planning to migrate site-to-site VPN and RA VPN, skip to step
7.

ASA CLI

(Optional) Export AnyConnect packages and profiles from ASA CLI: This
step is required only if you are planning to migrate RA VPN features from
ASA to threat defense. To export AnyConnect packages and profiles from
ASA CLI, see Retrieve AnyConnect Packages and Profiles. If you are not
planning to migrate site-to-site VPN and RA VPN, skip to step 7.

Management Center (Optional) Import the PKI certificates and Anyconnect packages to
management center: To import the PKI certificates to management center,
see Export PKI Certificate from ASA and Import into Management Center
and Retrieve AnyConnect Packages and Profiles.
Local Machine

Launch the Secure Firewall migration tool on your local machine, see Launch
the Secure Firewall Migration Tool.

Secure Firewall
Migration Tool

(Optional) Upload the ASA config file obtained from ASA CLI, see Upload
the ASA Configuration File. If you are planning to connect to live ASA, skip
to step 8.

Secure Firewall
Migration Tool

You can connect to live ASA directly from the Secure Firewall migration
tool. For more information, see Connect to the ASA from the Secure Firewall
Migration Tool.

Secure Firewall
Migration Tool

During this step, you can specify the destination parameters for the migration.
For detailed steps, see Specify Destination Parameters for the Secure Firewall
Migration Tool.

CDO

(Optional) This step is optional and only required if you have selected
cloud-delivered Firewall Management Center as destination management
center. For detailed steps, see Specify Destination Parameters for the Secure
Firewall Migration Tool.

Secure Firewall
Migration Tool

Navigate to where you downloaded the pre migration report and review the
report. For detailed steps, see Review the Pre-Migration Report.

Secure Firewall
Migration Tool

The Secure Firewall migration tool allows you to map the ASA configuration
with threat defense interfaces. For detailed steps, see Map ASA Configurations
with Secure Firewall Device Manager Threat Defense Interfaces.
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Workspace

Steps

Secure Firewall
Migration Tool

To ensure that the ASA configuration is migrated correctly, map the ASA
interfaces to the appropriate threat defense interface objects, security zones
and interface groups. For detailed steps, see Map ASA Interfaces to Security
Zones and Interface Groups.

Secure Firewall
Migration Tool

Optimize and review the configuration carefully and validate that it is correct
and matches how you want to configure the threat defense device. For detailed
steps, see Optimize, Review and Validate the Configuration to be migrated.

Secure Firewall
Migration Tool

This step in the migration process sends the migrated configuration to
management center and allows you to download the post-migration report.
For detailed steps, see Push the Migrated Configuration to Management
Center.

Local Machine

Navigate to where you downloaded the post migration report and review the
report. For detailed steps, see Push the Migrated Configuration to Management
Center.

Management Center Deploy the migrated configuration from the management center to threat
defense. For detailed steps, see Review the Post-Migration Report and
Complete the Migration.

Prepare For Migration
Before you migrate your ASA configuration, execute the following activities:

Download the Secure Firewall Migration Tool from Cisco.com
Before you begin
You must have a Windows 10 64-bit or macOS version 10.13 or higher machine with an internet connectivity
to Cisco.com.
Procedure

Step 1

On your computer, create a folder for the Secure Firewall migration tool.
We recommend that you do not store any other files in this folder. When you launch the Secure Firewall
migration tool, it places the logs, resources, and all other files in this folder.
Note

Step 2

Whenever you download the latest version of the Secure Firewall migration tool, ensure, you create
a new folder and not use the existing folder.

Browse to https://software.cisco.com/download/home/286306503/type and click Firewall Migration Tool.
The above link takes you to the Secure Firewall migration tool under Firewall NGFW Virtual. You can also
download the Secure Firewall migration tool from the threat defense device download areas.

Migrating Secure Firewall ASA to Threat Defense with the Migration Tool
27

ASA to Threat Defense Migration Workflow
Obtain the ASA Configuration File

Step 3

Download the most recent version of the Secure Firewall migration tool into the folder that you created.
Download the appropriate executable of the Secure Firewall migration tool for Windows or macOS machines.

What to do next
Obtain the ASA Configuration File

Obtain the ASA Configuration File
You can use one of the following methods to obtain an ASA configuration file:
• Export the ASA Configuration File, on page 28
• Connect to the ASA from the Secure Firewall Migration Tool, on page 33

Export the ASA Configuration File
This task is required only if you want to manually upload an ASA configuration file. If you want to connect
to an ASA from the Secure Firewall migration tool, skip to Connect to the ASA from the Secure Firewall
Migration Tool, on page 33.

Note

Do not hand code or make changes to the ASA configuration after you export the file. These changes
will not be migrated to threat defense, and they create errors in the migration or cause the migration to
fail. For example, opening and saving the configuration file in terminal can add white space or blank
lines that the Secure Firewall migration tool cannot parse.
Ensure that the exported ASA configuration file does not contain the "--More--" keyword as text, as this
can cause the migration to fail.

Procedure

Step 1

Use the show running-config command for the ASA device or context that you are migrating and copy the
configuration from there. See View the Running Configuration.
Alternately, use Adaptive Security Device Manager (ASDM) for the ASA device or context that you want to
migrate and choose File > Show Running Configuration in New Window to obtain the configuration file.
Note

Step 2

For a multi context ASA, you can use the show tech-support command to obtain the configuration
for all the contexts in a single file.

Save the configuration as either .cfg or .txt.
You cannot upload the ASA configuration to the Secure Firewall migration tool if it has a different extension.

Step 3

Transfer the ASA configuration file to your computer where you downloaded the Secure Firewall migration
tool.

Migrating Secure Firewall ASA to Threat Defense with the Migration Tool
28

ASA to Threat Defense Migration Workflow
Export PKI Certificate from ASA and Import into Management Center

Export PKI Certificate from ASA and Import into Management Center
Before you begin
The Secure Firewall migration tool supports migration of Certificate-based VPN into the management center.
ASA uses the trustpoint model for storing certificates in the configuration. A trustpoint is a container in which
certificates are stored. ASA trustpoint can store up to two certificates.
The ASA trustpoint or certificates in the ASA configuration file contains hash values. Hence, you cannot
directly import them into a management center.
In the destination management center, migrate the ASA trustpoint or the VPN certificates manually as PKI
objects as part of the pre-migration activity.
Procedure

Step 1

Use the following command to export the PKI certificate through the CLI from the source ASA config with
the keys to a PKCS12 file.
ASA(config)#crypto ca export <trust-point-name> pkcs12 <passphrase>

Step 2

Import the PKI certificate into a management center (Object Management PKI Objects).
For more information, see Firewall Management Center Configuration Guide.
The manually created PKI objects can now be used in the Secure Firewall migration tool in the Review and
Validate Page under the Trustpoint section in Remote Access VPN.

Retrieve AnyConnect Packages and Profiles
AnyConnect profiles are optional and can be uploaded through the management center or Secure Firewall
migration tool.
Before you begin
• Remote Access VPN on the management center requires at least one AnyConnect package.
• If the configuration consists of Hostscan and External Browser package, you must upload these packages.
• All packages have to be added to the management center as part of the pre-migration activity.
• Dap.xml and Data.xml must be added through the Secure Firewall migration tool.
Procedure

Step 1

Use the following command to copy the required package from the source ASA to an FTP or TFTP server.
Copy <source file location:/source file name> <destination>
ASA# copy disk0:/anyconnect-win-4.10.02086-webdeploy-k9.pkg tftp://1.1.1.1 <----- Example
of copying Anyconnect Package.
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ASA# copy disk0:/ external-sso- 4.10.04071-webdeploy-k9.zip tftp://1.1.1.1 <----- Example
of copying External Browser Package.
ASA# copy disk0:/ hostscan_4.10.04071-k9.pkg tftp://1.1.1.1 <----- Example of copying
Hostscan Package.
ASA# copy disk0:/ dap.xml tftp://1.1.1.1. <----- Example of copying Dap.xml
ASA# copy disk0:/ sdesktop/data.xml tftp://1.1.1.1 <----- Example of copying Data.xml
ASA# copy disk0:/ VPN_Profile.xml tftp://1.1.1.1 <----- Example of copying Anyconnect
Profile.

Step 2

Import the downloaded packages to management center (Object Management > VPN > AnyConnect File).
a. Dap.xml and Data.xml must be uploaded to the management center from the Secure Firewall migration
tool in the Review and Validate > Remote Access VPN > AnyConnect File section.
b. AnyConnect profiles can be uploaded directly to the management center or through the Secure Firewall
migration tool in the Review and Validate > Remote Access VPN > AnyConnect File section.
The manually uploaded files can now be used in the Secure Firewall migration tool.

Run the Migration
Launch the Secure Firewall Migration Tool
Note

When you launch the Secure Firewall migration tool a console opens in a separate window. As you go
through the migration, the console displays the progress of the current step in the Secure Firewall
migration tool. If you do not see the console on your screen, it is most likely to be behind the Secure
Firewall migration tool.

Before you begin
• Download the Secure Firewall Migration Tool from Cisco.com
• Review and verify the requirements in the Supported Target Management Center for Migration, on page
20 section.
• Ensure that your computer has a recent version of the Google Chrome browser to run the Secure Firewall
migration tool. For information on how to set Google Chrome as your default browser, see Set Chrome
as your default web browser.
• If you are planning to migrate a large configuration file, configure sleep settings so the system doesn’t
go to sleep during a migration push.
Procedure

Step 1

On your computer, navigate to the folder where you downloaded the Secure Firewall migration tool.

Step 2

Do one of the following:
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• On your Windows machine, double-click the Secure Firewall migration tool executable to launch it in
a Google Chrome browser.
If prompted, click Yes to allow the Secure Firewall migration tool to make changes to your system.
The Secure Firewall migration tool creates and stores all related files in the folder where it resides,
including the log and resources folders.
• On your Mac move, the Secure Firewall migration tool *.command file to the desired folder, launch the
Terminal application, browse to the folder where the Secure Firewall migration tool is installed and run
the following commands:
# chmod 750 Firewall_Migration_Tool-version_number.command
# ./Firewall_Migration_Tool-version_number.command

The Secure Firewall migration tool creates and stores all related files in the folder where it resides,
including the log and resources folders.

Step 3

Tip

When you try to open the Secure Firewall migration tool, you get a warning dialog because
the Secure Firewall migration tool is not registered with Apple by an identified developer. For
information on opening an application from an unidentified developer, see Open an app from
an unidentified developer.

Note

Use MAC terminal zip method.

On the End User License Agreement page, click I agree to share data with Cisco Success Network if you
want to share telemetry information with Cisco, else click I'll do later.
When you agree to send statistics to Cisco Success Network, you are prompted to log in using your Cisco.com
account. Local credentials are used to log in to the Secure Firewall migration tool if you choose not to send
statistics to Cisco Success Network.

Step 4

On the Secure Firewall migration tool's login page, do one of the following:
• To share statistics with Cisco Success Network, click the Login with CCO link to log in to your Cisco.com
account using your single sign-on credentials.
If you do not have a Cisco.com account, create it on the Cisco.com login page.

Note

• Log in with the following default credentials:
• Username—admin
• Password—Admin123
Proceed to step 8, if you have used your Cisco.com account to log in.
Step 5

On the Reset Password page, enter the old password, your new password, and confirm the new password.
The new password must have 8 characters or more and must include upper and lowercase letters, numbers,
and special characters.

Step 6

Click Reset.

Step 7

Log in with the new password.
Note

If you have forgotten the password, delete all the existing data from the <migration_tool_folder>
and reinstall the Secure Firewall migration tool.
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Step 8

Review the pre-migration checklist and make sure you have completed all the items listed.
If you have not completed one or more of the items in the checklist, do not continue until you have done so.

Step 9

Click New Migration.

Step 10

On the Software Update Check screen, if you are not sure you are running the most recent version of the
Secure Firewall migration tool, click the link to verify the version on Cisco.com.

Step 11

Click Proceed.

What to do next
You can proceed to the following step:
• If you have exported ASA configuration to your computer, proceed to Upload the ASA Configuration
File.
• If you want to extract information from an ASA using the Secure Firewall migration tool, proceed to
Connect to the ASA from the Secure Firewall Migration Tool, on page 33

Upload the ASA Configuration File
Before you begin
Export the configuration file as .cfg or .txt from the source ASA device.

Note

Do not upload a hand coded or manually altered configuration file. Text editors add blank lines and
other issues to the file that can cause the migration to fail.

Procedure

Step 1

On the Extract ASA Information screen, in the Manual Upload section, click Upload to upload an ASA
configuration file.

Step 2

Browse to where the ASA configuration file is located and click Open.
The Secure Firewall migration tool uploads the configuration file. For large configuration files, this step takes
a longer time. The console provides a line by line log view of the progress, including the ASA configuration
line that is being parsed. If you do not see the console, you can find it in a separate window behind the Secure
Firewall migration tool. The Context Selection section identifies if the uploaded configuration corresponds
to the multi-context ASA.

Step 3

Review the Context Selection section and select the ASA context that you want to migrate.

Step 4

Click Start Parsing.
The Parsed Summary section displays the parsing status.

Step 5

Review the summary of the elements in the uploaded configuration file that the Secure Firewall migration
tool detected and parsed.
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Step 6

Click Next to select the target parameters.

What to do next
Specify Destination Parameters for the Secure Firewall Migration Tool, on page 34

Connect to the ASA from the Secure Firewall Migration Tool
The Secure Firewall migration tool can connect to an ASA device that you want to migrate and extract the
required configuration information.
Before you begin
• Download and launch the Secure Firewall migration tool.
• For single context ASA, obtain the management IP address, administrator credentials, and the enable
password.
• For multi-context mode ASA, obtain the IP address of the admin context, administrator credentials, and
the enable password.

Note

If ASA is not configured with Enable Password, you can leave the field
blank on the Secure Firewall migration tool.

Procedure

Step 1

On the Extract ASA Information screen, in the Connect to ASA section, click Connect to connect to the
ASA device that you want to migrate.

Step 2

On the ASA Login screen, enter the following information:
a. In the ASA IP Address/Hostname field, enter the management IP address or hostname (for single context
ASA) or IP address of the admin context or hostname (for a multi-context ASA).
b. In the Username, Password, and Enable Password fields enter the appropriate administrator login
credentials.
Note

If ASA is not configured with an Enable password, you can leave the field blank on the Secure
Firewall migration tool.

c. Click Login.
When the Secure Firewall migration tool connects to the ASA, it displays a successfully connected to the
ASA message. For a multi-context ASA, the Secure Firewall migration tool identifies and lists the contexts.
Step 3

Select the ASA context that you want to migrate from the Context drop-down list.

Step 4

(Optional) Select Collect Hitcounts.
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When checked, this tool computes the number of times an ASA rule was used and the last time the rule was
used since ASA uptime or last ASA restart and displays this information on the Review and Validate page.
This allows you to evaluate the efficacy and relevance of the rule before migration.
Step 5

Click Start Extraction.
The Secure Firewall migration tool connects to the ASA and starts extracting configuration information. When
the extraction completes successfully, the Context Selection section identifies if the uploaded configuration
corresponds to a single-context or multi-context ASA.

Step 6

Review the Context Selection section and select the ASA context that you want to migrate.

Step 7

Click Start Parsing.
The Parsed Summary section displays the parsing status. The Secure Firewall migration tool parses the
configuration file and disconnects from the ASA.

Step 8

Review the summary of the elements that the Secure Firewall migration tool detected and parsed in the
uploaded configuration file.

Step 9

Click Next to select the target parameters.

What to do next
Specify Destination Parameters for the Secure Firewall Migration Tool, on page 34

Specify Destination Parameters for the Secure Firewall Migration Tool
Before you begin
• Obtain the IP address for the management center for On-Prem Firewall Management Center.
• From Secure Firewall Migration Tool 3.0 onwards, you can select between On-Prem Firewall Management
Center or Cloud-delivered Firewall Management Center.
• For Cloud-delivered Firewall Management Center, region and API token have to be provided. For more
information, seeSupported Target Management Center for Migration, on page 20.
• Create a dedicated account for the Secure Firewall migration tool in the management center with sufficient
privileges to access the REST API, as described in User Accounts for Management Access.
• (Optional) If you want to migrate device-specific configurations like interfaces and routes, add the target
threat defense device to the management center. See Adding Devices to the Firewall Management Center
• If it requires you to apply IPS or file policy to ACL in the Review and Validate page, we highly
recommend you to create a policy on the management center before migration. Use the same policy, as
the Secure Firewall migration tool fetches the policy from the connected management center. Creating
a new policy and assigning it to multiple access control lists may degrade the performance and may also
result in a push failure.
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Procedure

Step 1

On the Select Target screen, in the Firewall Management section, do the following: you can choose to
migrate to an On-Prem Firewall Management Center or Cloud-delivered Firewall Management Center:
• For migrating to an On-Prem Firewall Management Center, do the following:
a) Click the On-Prem FMC radio button.
b) Enter the IP address or Fully-Qualified Domain Name (FQDN) for the management center.
c) In the Domain drop-down list, select the domain to which you are migrating.
If you want to migrate to a threat defense device, you can only migrate to the threat defense devices
available in the selected domain.
d) Click Connect and proceed to Step 2.
• For migrating to a Cloud-delivered Firewall Management Center, do the following:
a) Click the Cloud-delivered FMC radio button.
b) Choose the region and paste the CDO API token. For generating the API token. from CDO, follow the
below steps:
1. Log in to CDO portal.
2. Navigate to Settings > General Settings and copy the API Token.
c) Click Connect and proceed to Step 2.

Step 2

In the Firewall Management Center Login dialog box, enter the username and password of the dedicated
account for the Secure Firewall migration tool, and click Login.
The Secure Firewall migration tool logs in to the management center and retrieves a list of threat defense
devices that are managed by that management center. You can view the progress of this step in the console.

Step 3

Click Proceed.
In the Choose Threat Defense section, you can either select a threat defense device that you want to migrate
to, or if you do not have a threat defense device, you can migrate the shared policies (Access Control Lists,
NAT, and Objects) of the ASA configuration to the management center.

Step 4

In the Choose Threat Defense section, do one of the following:
• Click the Select Firewall Threat Defense Device drop-down list and check the device where you want
to migrate the ASA configuration.
The devices in the selected management center domain are listed by IP Address and Name.
Note

At minimum, the native threat defense device you choose must have the same number of
physical or port channel interfaces as the ASA configuration that you are migrating. At
minimum, the container instance of the threat defense device must have the same number of
physical or port channel interfaces and subinterfaces. You must configure the device with the
same firewall mode as the ASA configuration. However, these interfaces do not have to have
the same names on both devices.
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Table 2: ASA Firewall Features and Supported Management Center or Threat Defense Versions

Firewall Features

Supported Management Center or Threat Defense
Version

ASA with remote deployment

6.7 or later

Crypto Map Site-to-Site VPN

6.6 or later

Virtual Tunnel Interface (VTI) and Route-based
(VTI)

6.7 or later

Dynamic-Route Objects and BGP

7.1 or later

Remote Access VPN

• Management Center 7.2 or later
• Threat Defense 7.0 or later.

EIGRP

• Management Center 7.2 or later
• Threat Defense 7.0 or later.

Note

To migrate Site-to-Site VPN, VTI, and Route-based (VTI) interfaces, threat defense must be
configured on management center.

• For ASA 5505, the device-specific configs (Interface and routes) and shared policies (NAT, ACLs, and
Objects) can be migrated only when the supported target threat defense platform is Firewall 1010 with
management center version 6.5 or later.
Note

If the target threat defense is not FPR-1010 or the target management center is earlier than 6.5,
ASA 5505 migration support is applicable for shared policies only. Device specifics will not
be migrated.

Note

You can select only FPR-1010 in the Select Device drop-down list as the source config is ASA
5505.

Note

ASA-SM migration support is for shared policies only. Device specifics will not be migrated.

• Click Proceed without Threat Defense to migrate the configuration to the management center.
When you proceed without threat defense, the Secure Firewall migration tool will not push any
configurations or the policies to threat defense. Thus, interfaces and routes, and site-to-site VPN which
are threat defense device-specific configurations, will not be migrated. However, all the other supported
configurations (shared policies and objects) such as NAT, ACLs, and port objects will be migrated.
Remote Access VPN is a shared policy and can be migrated even without threat defense.
Step 5

Click Proceed.
Depending on the destination that you are migrating to, the Secure Firewall migration tool allows you to select
the features that you want to migrate.

Step 6

Click the Select Features section to review and select the features that you want to migrate to the destination.
• If you are migrating to a destination threat defense device, the Secure Firewall migration tool automatically
selects the features available for migration from the ASA configuration in the Device Configuration
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and Shared Configuration sections. You can further modify the default selection, according to your
requirements.
• If you are migrating to a management center, the Secure Firewall migration tool automatically selects
the features available for migration from the ASA configuration in the Shared Configuration section.
You can further modify the default selection, according to your requirements.
The Device Configuration section is not available when you have not selected a destination
threat defense device to migrate to.

Note

• The Secure Firewall migration tool supports the following for access control during migration:
• Populate Destination Security Zones—Enables mapping of destination zones for the ACL during
migration.
Route-lookup logic is limited to Static Routes and Connected Routes, whereas PBR, Dynamic
Routes, and NAT are not considered. Interface network configuration is used to derive the connected
route information.
Based on the nature of Source and Destination network object-groups, this operation may result in
rule explosion.
• Migrate Tunneled rules as Prefilter—Mapping of ASA encapsulated tunnel protocol rule to Prefilter
tunnel rules has the following advantages:
• Tailor Deep Inspection—For encapsulated traffic and to improve performance with fastpathing.
• Improve Performance—You can fastpath or block any other connections that benefit from
early handling.
The Secure Firewall migration tool identifies the encapsulated tunnel traffic rules in source
configuration and migrates them as Prefilter tunnel rules. You can verify the migrated tunnel rule
under the Prefilter policy. The Prefilter policy is associated with the migrated access control policy
on management center.
The protocols which are migrated as Prefilter tunnel rules are following:
• GRE (47)
• IPv4 encapsulation (4)
• IPv6 encapsulation (41)
• Teredo Tunneling (UDP:3544)
Note

If you do not opt to select the prefilter option, all the tunneled traffic rules will be migrated
as unsupported rules.

The ACL tunnel rules (GRE and IPnIP) in the ASA configuration are currently migrated as
bidirectional by default. You can now specify the Rule direction for the destination as bidirectional
or unidirectional in the access control state option.
• The Secure Firewall migration tool supports the following interfaces and objects for VPN Tunnel
migration:
• Policy-based (Crypto Map)—If the target management center and threat defense is version 6.6 or
later.
• Route-based (VTI)—If the target management center and threat defense is version 6.7 or later.
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• The Secure Firewall migration tool supports migration of Remote Access VPN if the target management
center is 7.2 or later. Remote Access VPN is a shared policy that can be migrated without threat defense.
If migration is selected with threat defense, the threat defense version should be 7.0 or later.
• (Optional) In the Optimization section, select Migrate only referenced objects to migrate only those
objects that are referenced in an access control policy and a NAT policy.
Note

When you select this option, unreferenced objects in the ASA configuration will not be migrated.
This optimizes migration time and cleans out unused objects from the configuration.

• (Optional) In the Optimization section, select Object group search for optimal memory utilization by
access policy on threat defense.
• (Optional) In the Inline Grouping section, the Secure Firewall migration tool allows you to clear the
access rules of the pre-defined network and service object names that start with CSM or DM. If you
uncheck this option, the pre-defined object names will be retained during migration. For more information,
see Inline Grouping.
Note

By default, the option of Inline Grouping is enabled.

Step 7

Click Proceed.

Step 8

In the Rule Conversion/ Process Config section, click Start Conversion to initiate the conversion.

Step 9

Review the summary of the elements that the Secure Firewall migration tool converted.
To check whether your configuration file is successfully uploaded and parsed, download and verify the
Pre-Migration Report before you continue with the migration.

Step 10

Click Download Report and save the Pre-Migration Report.
A copy of the Pre-Migration Report is also saved in the Resources folder in the same location as the
Secure Firewall migration tool.

What to do next
Review the Pre-Migration Report, on page 39

Inline Grouping
Object Grouping by ASDM and CSM Managed ASA
When you enter more than one item (object or inline values) in the source or destination address, or source
or destination service, CSM or ASDM automatically creates an object group. The naming conventions for
these object groups that are used by CSM and ASDM are CSM_INLINE and DM_INLINE respectively while
deploying the configuration on to respective ASA device.

Note

To change the behavior of the object grouping from Tools > Preferences, choose Auto-expand network
and service objects with specified prefix rule table preference.

The following is the configuration snippet extracted using the show run command on ASA managed by
ASDM.
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object network host1
host 10.1.1.100
object network fqdn_obj1
fqdn abc.cisco.com
object-group network DM_INLINE_NETWORK_1
network-object 10.21.44.189 255.255.255.255
network-object 10.21.44.190 255.255.255.255
object-group network DM_INLINE_NETWORK_2
network-object 10.21.44.191 255.255.255.255
network-object object host1
network-object object fqdn_obj1

access-list CSM_DM_ACL extended permit tcp object-group DM_INLINE_NETWORK_1 object-group
DM_INLINE_NETWORK_2

In the above example, access-list CSM_DM_ACL on ASDM UI does not show DM_INLINE group as rule’s
Source and Destination network instead displays contents of DM_INLINE group.
Inline Grouping—ASDM/CSM
The Inline Grouping functionality of the Secure Firewall migration tool allows you to parse show
running-configuration of ASDM or CSM managed ASA devices. It provides an option to preserve the same
UI representation of the access-list rules as on ASDM or CSM. If opted out, migrated rules will refer to
DM_INLINE groups as recorded in ASA show running-configuration.

Note

The source ASA configuration file input to the Secure Firewall migration tool would still be show run
or show tech collected from ASA or via live connection to ASA device (SSH). The Secure Firewall
migration tool does not support any other form of configuration files or methods.

The following figures show how the Source and Destination Network fields of ACE or RULE change based
on the enabling or disabling the inline grouping option respectively.
Figure 1: With Inline Grouping—ASDM/CSM Enabled

Figure 2: With Inline Grouping—ASDM/CSM Disabled

Review the Pre-Migration Report
If you have missed to download the Pre-Migration Reports during migration, use the following link to download:
Pre-Migration Report Download Endpoint—http://localhost:8888/api/downloads/pre_migration_summary_
html_format

Migrating Secure Firewall ASA to Threat Defense with the Migration Tool
39

ASA to Threat Defense Migration Workflow
Review the Pre-Migration Report

Note

You can download the reports only when the Secure Firewall migration tool is running.

Procedure

Step 1

Navigate to where you downloaded the Pre-Migration Report.
A copy of the Pre-Migration Report is also saved in the Resources folder in the same location as the
Secure Firewall migration tool.

Step 2

Open the Pre-Migration Report and carefully review its contents to identify any issues that can cause the
migration to fail.
The Pre-Migration Report includes the following information:
• Overall Summary—The method used to extract the ASA configuration information or connecting to a
live ASA configuration.
If connecting to a live ASA, the firewall mode detected on the ASA, and for multiple context mode, the
context you chose for migration.
A summary of the supported ASA configuration elements that can be successfully migrated to threat
defense and specific ASA features selected for migration.
While connecting to a live ASA, the summary includes the hit count information- the number of times
an ASA rule was encountered and its time-stamp information.
• Configuration Lines with Errors—Details of ASA configuration elements that cannot be successfully
migrated because the Secure Firewall migration tool could not parse them. Correct these errors on the
ASA configuration, export a new configuration file, and then upload the new configuration file to the
Secure Firewall migration tool before proceeding.
• Partially Supported Configuration—Details of ASA configuration elements that can be only partially
migrated. These configuration elements include rules and objects with advanced options where the rule
or the object can be migrated without the advanced options. Review these lines, verify whether the
advanced options are supported in management center, and if so, plan to configure those options manually
after you complete the migration with the Secure Firewall migration tool.
• Unsupported Configuration—Details of ASA configuration elements that cannot be migrated because
the Secure Firewall migration tool does not support migration of those features. Review these lines,
verify whether each feature is supported in management center, and if so, plan to configure the features
manually after you complete the migration with the Secure Firewall migration tool.
• Ignored Configuration—Details of ASA configuration elements that are ignored because they are not
supported by the management center or the Secure Firewall migration tool. The Secure Firewall migration
tool does not parse these lines. Review these lines, verify whether each feature is supported in management
center, and if so, plan to configure the features manually.
For more information about supported features in management center and threat defense, see Management
Center Configuration Guide.

Step 3

If the Pre-Migration Report recommends corrective actions, complete those corrections on the ASA interface,
export the ASA configuration file again and upload the updated configuration file before proceeding.
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Step 4

After your ASA configuration file is successfully uploaded and parsed, return to the Secure Firewall migration
tool, and click Next to continue the migration.

What to do next
Map ASA Configurations with Secure Firewall Device Manager Threat Defense Interfaces

MapASAConfigurationswithSecureFirewallDeviceManagerThreatDefense
Interfaces
The threat defense device must have an equal or greater number of physical and port channel interfaces than
those used by ASA configuration. These interfaces do not have to have the same names on both devices. You
can choose how you want to map the interfaces.
On the Map Threat Defense Interface screen, the Secure Firewall migration tool retrieves a list of the
interfaces on the threat defense device. By default, the Secure Firewall migration tool maps the interfaces in
ASA and the threat defense device according to their interface identities. For example, the 'management-only'
interface on the ASA interface is automatically mapped to the 'management-only' interface on the threat
defense device and is unchangeable.
The mapping of ASA interface to the threat defense interface differs based on the threat defense device type:
• If the target threat defense is of native type:
• The threat defense must have equal or more number of used ASA interfaces or port channel (PC)
data interfaces (excluding management-only and subinterfaces in the ASA configuration). If the
number is less, add the required type of interface on the target threat defense.
• Subinterfaces are created by the secure Firewall migration tool based on physical interface or port
channel mapping.
• If the target threat defense is of container type:
• The threat defense must have equal or more number of used ASA interfaces, physical subinterfaces,
port channel, or port channel subinterfaces (excluding management-only in ASA configuration). If
the number is less, add the required type of interface on the target threat defense. For example, if
the number of physical interfaces and physical subinterface on the target threat defense is 100 less
than that of ASA then you can create the additional physical or physical subinterfaces on the target
threat defense.
• Subinterfaces are not created by the Secure Firewall migration tool. Only interface mapping is
allowed between physical interfaces, port channel, or subinterfaces.

Before you begin
Make sure you have connected to the management center and chosen the destination as threat defense. For
more information, see Specify Destination Parameters for the Secure Firewall Migration Tool, on page 34.

Note

This step is not applicable if you are migrating to a management center without a threat defense device.
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Procedure

Step 1

If you want to change an interface mapping, click the drop-down list in the Threat Defense Interface Name
and choose the interface that you want to map to that ASA interface.
You cannot change the mapping of the management interfaces. If a threat defense interface has already been
assigned to an ASA interface, you cannot choose that interface from the drop-down list. All assigned interfaces
are greyed out and unavailable.
You do not need to map subinterfaces. The Secure Firewall migration tool maps subinterfaces on the threat
defense device for all subinterfaces in the ASA configuration.

Step 2

When you have mapped each ASA interface to a threat defense interface, click Next.

What to do next
Map the ASA interfaces to the appropriate threat defense interface objects, security zones, and interface
groups. For more information, see Map ASA Interfaces to Security Zones and Interface Groups.

Map ASA Interfaces to Security Zones and Interface Groups
Note

If your ASA configuration does not include Access Lists and NAT rules or if you choose not to migrate
these policies, you can skip this step and proceed to Optimize, Review and Validate the Configuration
to be migrated, on page 43.

To ensure that the ASA configuration is migrated correctly, map the ASA interfaces to the appropriate threat
defense interface objects, security zones and interface groups. In an ASA configuration, access control policies
and NAT policies use interface names (nameif). In management center, those policies use interface objects.
In addition, management center policies group interface objects into the following:
• Security zones—An interface can belong to only one security zone.
• Interface groups—An interface can belong to multiple interface groups.
The Secure Firewall migration tool allows one-to-one mapping of interfaces with security zones and interface
groups; when a security zone or interface group is mapped to an interface, it is not available for mapping to
other interfaces although the management center allows it. For more information about security zones and
interface groups in management center, see Interface Objects: Interface Groups and Security Zones.
Procedure

Step 1

On the Map Security Zones and Interface Groups screen, review the available interfaces, security zones,
and interface groups.

Step 2

To map interfaces to security zones and interface groups that exist in management center, or that is available
in ASA configuration files as Security Zone type objects and is available in the drop-down list, do the following:
a) In the Security Zones column, choose the security zone for that interface.
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b) In the Interface Groups column, choose the interface group for that interface.
Step 3

You can manually map or auto-create the security zones and interface groups.

Step 4

To map the security zones and interface groups manually, perform the following:
a) Click Add SZ & IG.
b) In the Add SZ & IG dialog box, click Add to add a new security zone or Interface Group.
c) Enter the security zone name in the Security Zone column. The maximum characters allowed is 48.
Similarly, you can add an Interface group.
d) Click Close.
To map the security zones and interface groups through auto-creation, perform the following:
a) Click Auto-Create.
b) In the Auto-Create dialog box, check one or both of Interface Groups and Zone Mapping.
c) Click Auto-Create.
The Secure Firewall migration tool gives these security zones the same name as the ASA interface, such as
outside or inside, and displays an "(A)" after the name to indicate that it was created by the Secure Firewall
migration tool. The interface groups have an _ig suffix added, such as outside_ig or inside_ig. In addition,
the security zones and interface groups have the same mode as the ASA interface. For example, if the ASA
logical interface is in L3 mode, the security zone and interface group that is created for the interface is also
in L3 mode.

Step 5

When you have mapped all interfaces to the appropriate security zones and interface groups, click Next.

Optimize, Review and Validate the Configuration to be migrated
Before you push the migrated ASA configuration to management center, optimize and review the configuration
carefully and validate that it is correct and matches how you want to configure the threat defense device. A
flashing tab indicates that you must take the next course of action.

Note

If you close the Secure Firewall migration tool at the Optimize, Review and Validate Configuration
screen, it saves your progress and allows you to resume the migration later. If you close the Secure
Firewall migration tool before this screen, your progress is not saved. If there is a failure after parsing,
relaunching the Secure Firewall migration tool resumes from the Interface Mapping screen.

Here, the Secure Firewall migration tool fetches the Intrusion Prevention System (IPS) Policies and File
Policies which are already present on the management center and allows you to associate those to the Access
Control Rules you are migrating.
A file policy is a set of configurations that the system uses to perform Advanced Malware Protection for
networks and file control, as part of your overall access control configuration. This association ensures that
before the system passes a file in traffic that matches an access control rule’s conditions, it first inspects the
file.
Similarly, you can use an IPS policy as the system’s last line of defense before traffic is allowed to proceed
to its destination. Intrusion policies govern how the system inspects traffic for security violations and, in inline
deployments, can block or alter malicious traffic. Whenever the system uses an intrusion policy to evaluate
traffic, it uses an associated variable set. Most variables in a set represent values commonly used in intrusion
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rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies
to represent IP addresses in rule suppression and dynamic rule states.
To search for specific configuration items on a tab, enter the item name in the field at the top of the column.
The table rows are filtered to display only items that match the search term.
The source ASA device may be managed by CSM or ASDM. When you enter more than one item (object or
inline values) in the source or destination address, or source or destination service, CSM or ASDM automatically
creates an object group. The naming conventions for these object groups that are used by CSM and ASDM
are CSM_INLINE and DM_INLINE respectively.
When you opt to clear the inline grouping CSM or ASDM managed configurations, the predefined objects
are replaced with the actual object or member name. If you do not clear the CSM or ASDM managed
configurations, the predefined object names will be retained for migration.
For example, 10.21.44.189 and 10.21.44.190 are members of an object group and are renamed with the
predefined names such as object-group DM_INLINE_NETWORK_1 and object-group
DM_INLINE_NETWORK_2.

Note

By default, the Inline Grouping option is enabled.

If you close the Secure Firewall migration tool at the Optimize, Review and Validate Configuration screen,
it saves your progress and allows you to resume the migration later. If you close the before this screen, your
progress is not saved. If there is a failure after parsing, relaunching the Secure Firewall migration tool resumes
from the Interface Mapping screen.
Secure Firewall Migration Tool ACL Optimization Overview
The Secure Firewall migration tool provides support to identify and segregate ACLs that can be optimized
(disabled or deleted) from the firewall rule base without impacting the network functionality.
The ACL optimization supports the following ACL types:
• Redundant ACL—When two ACLs have the same set of configurations and rules, then removing the
non-base ACL will not impact the network. For example, if any two rule allows FTP and IP traffic on
the same network with no rules that are defined for denying access, the first rule can be deleted.
• Shadow ACL—The first ACL completely shadows the configurations of the second ACL. If two rules
have similar traffic, the second rule is not applied to any traffic as it appears later in the access list. If the
two rules specify different actions for traffic, you can either move the shadowed rule or edit any one of
the rules to implement the required policy. For example, the base rule may deny the IP traffic, and the
shadowed rule may allow FTP traffic for a given source or destination.
The Secure Firewall migration tool uses the following parameters while comparing rules for ACL optimization:

Note

Optimization is available for the ASA only for ACP rule action.
• The disabled ACLs are not considered during the optimization process.
• The source ACLs are expanded into the corresponding ACEs (inline values), and then compared for the
following parameters:
• Source and Destination Zones
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• Source and Destination Network
• Source and Destination Port
Object Optimization
The following objects are considered for Object optimization during the migration process:
• Unreferenced objects—You can choose not to migrate unreferenced objects at the beginning of the
migration.
• Duplicate objects—If an object already exists on management center, instead of creating a duplicate
object, the policy is reused.
Procedure

Step 1

(Optional) On the screen, click Optimize ACL to run the optimization code, and perform the following:
a) To download the identified ACL optimization rules, click Download.
b) Select rules and choose Actions > Migrate as disabled or Do not migrate and apply one of the actions.
c) Click Save.
The migration operation changes from Do not migrate to disabled or vice-versa.
You can perform bulk selection of rules, using the following options
• Migrate—To migrate with default state.
• Do not Migrate—To ignore the migration of ACLs.
• Migrate as disabled—To migrate ACLs with State field set to Disable.
• Migrate as enabled—To migrate ACLs will with State field set to Enable.

Step 2

On the Optimize, Review and Validate Configuration screen, click Access Control Rules and do the
following:
a) For each entry in the table, review the mappings and verify that they are correct.
A migrated Access Policy Rule uses the ACL name as prefix and appends the ACL rule number to it to
make it easier to map back to the ASA configuration file. For example, if an ASA ACL is named
"inside_access," then the first rule (or ACE) line in the ACL will be named as "inside_access_#1." If a
rule must be expanded because of TCP or UDP combinations, an extended service object, or some other
reason, the Secure Firewall migration tool adds a numbered suffix to the name. For example, if the allow
rule is expanded into two rules for migration, they are named "inside_access _#1-1" and "
inside_access_#1-2".
For any rule that includes an unsupported object, the Secure Firewall migration tool appends an
"_UNSUPPORTED" suffix to the name.
b) If you do not want to migrate one or more access control list policies, check the box for the appropriate
rows, choose Actions > Do not migrate, and then click Save.
All rules that you choose not to migrate are grayed out in the table.
c) If you want to apply a management center file policy to one or more access control policies, check the
box for the appropriate rows, choose Actions > File Policy.
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In the File Policy dialog, select the appropriate file policy and apply it to the selected access control
policies and click Save.
d) If you want to apply a management center IPS policy to one or more access control policies, check the
box for the appropriate rows, choose Actions > IPS Policy.
In the IPS Policy dialog, select the appropriate IPS policy and its corresponding variable set and apply it
to the selected access control policies and click Save.
e) If you want to change the logging options for an access control rule which has logging enabled, check the
box for the appropriate row and choose Actions > Log.
In the Log dialog, you can enable logging events either at the beginning or end of a connection or both.
If you enable logging, you must opt to send the connection events either to the Event Viewer or to the
Syslog or both. When you opt to send connection events to a syslog server, you can choose the syslog
policies that are already configured on the management center from the Syslog drop-down menu.
f) If you want to change the actions for the migrated access control rules in the Access Control table, check
the box for the appropriate row and choose Actions > Rule Action.
In the Rule Action dialog from the Actions drop-down, you can either choose ACP or Prefilter tabs:
• ACP—Every access control rule has an action that determines how the system handles and logs
matching traffic. You can either perform an allow, trust, monitor, block, or block with reset action
on an access control rule.
• Prefilter—A rule's action determines how the system handles and logs matching traffic. You can
either perform a fastpath and block.
Tip

The IPS and file policies that are attached to an access control rule will be automatically removed
for all rule actions except the Allow option.

ACL Rule Category—The Secure Firewall migration tool preserves the Rule sections in the CSM managed
ASA configuration and migrates them as ACL categories on management center.
Policy capacity and limit warning—The Secure Firewall migration tool compares the total ACE count
for the migrated rules with the supported ACE limit on the target platform.
Based on the comparison result, the Secure Firewall migration tool displays a visible indicator and a
warning message if the total count of migrated ACE exceeds threshold or if it approaches the threshold
of the supported limit of target device.
You can optimize or decide not to migrate if the rules exceed the ACE Count column. You can also
complete the migration and use this information to optimize the rules after a push on the management
center before deployment.
Note

The Secure Firewall migration tool does not block any migration despite the warning.

You can now filter the ACE counts in the ascending, descending, equal, greater than, and lesser than
filtering order sequence.
To clear the existing filter criteria, and to load a new search, click Clear Filter.
Note

Step 3

The order that you sort the ACL based on ACE is for viewing only. The ACLs are pushed based
on the chronological order in which they occur.

Click the following tabs and review the configuration items:
• NAT Rules

Migrating Secure Firewall ASA to Threat Defense with the Migration Tool
46

ASA to Threat Defense Migration Workflow
Optimize, Review and Validate the Configuration to be migrated

• Objects (Access List Objects, Network Objects, Port Objects, VPN Objects, and Dynamic-Route
Objects)
• Interfaces
• Routes
• Site-to-Site VPN Tunnels
• Remote Access VPN
Access List objects displays Standard and Extended ACL used in BGP, EIGRP, and RA VPN.
If you do not want to migrate one or more NAT rules or Route Interfaces, check the box for the appropriate
rows, choose Actions > Do not migrate, and then click Save.
All rules that you choose not to migrate are grayed out in the table.
Step 4

(Optional) While reviewing your configuration, you can rename one or more network, port, or VPN objects
in the Network Objects tab or the Port Objects tab, or the VPN Objects by choosing Actions > Rename.
Access Rules and NAT policies that reference the renamed objects are also updated with new object names.

Step 5

In the Dynamic-Route Objects section, all the supported objects that are migrated are displayed:
• Policy-List
• Prefix-List
• Route-Map
• Community List
• AS-Path
• Access-List

Step 6

In the Routes section, the following routes are displayed:
• Static—Displays all IPv4 and IPv6 static routes.
• BGP—Displays all the BGP routes.
• EIGRP—Displays all the EIGRP routes.
For EIGRP, authentication keys are obtained if the more system:running configuration is uploaded and
the keys are unencrypted. If the key is encrypted in the source configuration, you can manually provide
the key under the interface section in EIGRP. You can select the authentication type (encrypted,
unencrypted, auth, or none) and provide the key accordingly.

Step 7

In the Remote Access VPN section, all objects corresponding to Remote Access VPN are migrated from
ASA to management center and are displayed:
• Anyconnect Files—AnyConnect packages, Hostscan Files (Dap.xml, Data.xml, Hostscan Package),
External Browser package, and AnyConnect profiles should be retrieved from the source ASA device
and must be available for migration.
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As part of pre-migration activity, upload all AnyConnect packages to the management center. You can
upload AnyConnect profiles directly to the management center or from the Secure Firewall migration
tool.
Select pre-existing Anyconnect, Hostscan, or External Browser Packages retrieved from the management
center. You must select atleast one AnyConnect package. You must select Hostscan, dap.xml, data.xml,
or External browser if available in the source configuration. AnyConnect profiles are optional.
Dap.xml must be the correct file retrieved from ASA. Validations are performed on dap.xml that are
available in the configuration file. You must upload and select all the required files for validation. Failure
to update will be marked as incomplete and the Secure Firewall migration tool does not proceed with
validation.
• AAA—Authentication servers of Radius, LDAP, AD, LDAP, SAML, and Local Realm type are displayed.
Update the keys for all AAA servers. From Secure Firewall migration tool 3.0, the pre-shared keys are
retrieved automatically for a Live Connect ASA. You can also upload the source configuration with the
hidden keys using more system: running-config file.To retrieve the AAA authentication key in clear
text format, follow the below steps:
Note

These steps should be performed outside the Secure Firewall migration tool.

a. Connect to the ASA through the SSH console.
b. Enter the more system:running-config command.
c. Go to the aaa-server and local user section to find all the AAA config and the respective key values
in clear text format.
ciscoASA#more system:running-config
!
aaa-server Test-RADIUS (inside) host 2.2.2.2
key <key in clear text>
format.

<-----The radius key is now displayed in clear text

aaa-server Test-LDAP (inside) host 3.3.3.3
ldap-login-password <Password in clear text> <-----TheLDAP/AD/LDAPS password is now
displayed in clear text format.
username Test_User password <Password in clear text> <-----The Local user
password is shown in clear text.

Note

If the password for the local user is encrypted, you can internally check for the password
or configure a new one on the Secure Firewall migration tool.

• LDAPS requires domain on management center. You must update domain for encryption type LDAPS.
• Unique AD Primary Domain is required on management center for an AD server. If a unique domain is
identified, it will be displayed on the Secure Firewall migration tool. If conflict is found, you must enter
a unique AD primary domain to push the objects successfully.
For AAA server with encryption set to LDAPS, ASA supports IP and hostname or domain but the
management center supports only hostname or domain. If ASA config contains hostname or domain, it
is retrieved and displayed. If ASA config contains the IP address for LDAPS, enter a domain in the AAA
section under Remote Access VPN. You must enter the domain that can be resolved to the IP address
of the AAA server.
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For AAA server with type AD (server-type is Microsoft in ASA config), AD Primary Domain is a
mandatory field to be configured on a management center. This field is not configured separately on
ASA and extracted from the LDAP-base-dn config on ASA.
If the ldap-base-dn is: ou=Test-Ou,dc=gcevpn,dc=com

The AD Primary Domain is the field starting with dc, with dc=gcevpn, and dc=com that forms the
primary domain. The AD primary domain would be gcevpn.com.
LDAP-base-dn example file:
cn=asa,OU=ServiceAccounts,OU=abc,dc=abc,dc=com:

Here, dc=abc, and dc=com will be combined as abc.com to form the AD Primary Domain.
cn=admin, cn=users, dc=fwsecurity, dc=cisco, dc=com:

AD Primary Domain is fwsecurity.cisco.com.
AD Primary Domain is retrieved automatically and displayed on the Secure Firewall migration tool.
Note

AD Primary Domain value needs to be unique for each Realm object. In case a conflict is
detected or if the Firewall Migration Tool is unable to find the value in the ASA config, you
are requested to enter an AD Primary Domain for the specific server. Enter the AD Primary
Domain to validate the configuration.

• Address Pool—All IPv4 and IPv6 pools are displayed here.
• Group-Policy—This section shows group policies with client profiles, management profiles, client
modules, and group policies without profiles. If the profile was added in the AnyConnect file section, it
is displayed as pre-selected. You can select or remove the user profile, management profile, and client
module profile.
• Connection Profile—All connection profiles/tunnel groups are displayed here.
• Trustpoint—Trustpoint or PKI object migration from ASA to management center is part of the
pre-migration activity and is required for successful migration of RA VPN. Map the trustpoint for Global
SSL, IKEv2, and interface in the Remote Access Interface section to proceed with the next steps of
migration. Global SSL and IKEv2 Trustpoint are mandatory if the LDAPS protocol is enabled. If a SAML
object exists, trustpoint for SAML IDP and SP can be mapped in the SAML section. SP Certificate is
optional. Trustpoint can also be overridden for a specific tunnel-group. If the overriden SAML trustpoint
configuration is available in source ASA, it can be selected in Override SAML option.
For information on exporting PKI certificates from ASA, see Export PKI Certificate from ASA and
Import into Management Center.
• Certificate Maps—Certificate maps are displayed here.
Step 8

(Optional) To download the details for each configuration item in the grid, click Download.

Step 9

After you have completed your review, click Validate.
During validation, the Secure Firewall migration tool connects to management center, reviews the existing
objects, and compares those objects to the list of objects to be migrated. If an object already exists in
management center, the Secure Firewall migration tool does the following:
• If the object has the same name and configuration, the Secure Firewall migration tool reuses the existing
object and does not create a new object in management center.
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• If the object has the same name but a different configuration, the Secure Firewall migration tool reports
an object conflict.
You can view the validation progress in the console.
Step 10

When the validation is complete, if the Validation Status dialog box shows one or more object conflicts, do
the following:
a) Click Resolve Conflicts.
The Secure Firewall migration tool displays a warning icon on either or both of the Network Objects or
Port Objects tab, depending upon where the object conflicts were reported.
b) Click the tab and review the objects.
c) Check the entry for each object that has a conflict and choose Actions > Resolve Conflicts.
d) In the Resolve Conflicts window, complete the recommended action.
For example, you might be prompted to add a suffix to the object name to avoid a conflict with the existing
management center object. You can accept the default suffix or replace it with one of your own.
e) Click Resolve.
f) When you have resolved all object conflicts on a tab, click Save.
g) Click Validate to revalidate the configuration and confirm that you have resolved all object conflicts.

Step 11

When the validation is complete and the Validation Status dialog box displays the message Successfully
Validated, continue with Push the Migrated Configuration to Management Center, on page 51.

Reporting for ACL Optimization
The ACL optimization report displays the following information:
• Summary Sheet—Displays the summary of the ACL optimization.
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• Detailed ACL Information—Displays the details of base ACL. Each ACL comes with a ACL type
(Shadow or Redundant) tag to identify the base ACL for comparison and its association with the
optimization category.

Push the Migrated Configuration to Management Center
You cannot push the migrated ASA configuration to management center if you have not successfully validated
the configuration and resolved all object conflicts.
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This step in the migration process sends the migrated configuration to management center. It does not deploy
the configuration to the threat defense device. However, any existing configuration on the threat defense is
erased during this step.

Note

Do not make any configuration changes or deploy to any device while the Secure Firewall migration
tool is sending the migrated configuration to management center.

Procedure

Step 1

In the Validation Status dialog box, review the validation summary.

Step 2

Click Push Configuration to send the migrated ASA configuration to management center.
The new optimization functionality in the Secure Firewall migration tool allows you to fetch the migration
results quickly using the Search filters.
The Secure Firewall migration tool also provides support to optimize CSV download and to apply the actions
per page view or on all rules.
The Secure Firewall migration tool displays a summary of the progress of the migration. You can view detailed,
line-by-line progress of which the components that are being pushed to management center in the console.

Step 3

After the migration is complete, click Download Report to download and save the post-migration report.
Copy of the Post-Migration Report is also saved in the Resources folder in the same location as the
Secure Firewall migration tool.

Step 4

If your migration failed, review the post-migration report, log file, and unparsed file carefully to understand
what caused the failure.
You can also contact the support team for troubleshooting.
Migration Failure Support
If the migration is unsuccessful, contact Support.
a. On the Complete Migration screen, click the Support button.
The Help support page appears.
b. Check the Support Bundle check box and then select the configuration files to download.
Note

The Log and dB files are selected for download by default.

c. Click Download.
The support bundle file is downloaded as a .zip to your local path. Extract the Zip folder to view the log
files, DB, and the Configuration files.
d. Click Email us to email the failure details for the technical team.
You can also attach the downloaded support files to your email.
e. Click Visit TAC page to create a TAC case in the Cisco support page.
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Note

You can open a TAC case at any time during the migration from the support page.

Review the Post-Migration Report and Complete the Migration
The Post-migration report provides details on ACL count under various categories, ACL optimization, and
the overall view of optimization performed on the configuration file. For more information, see Optimize,
Review and Validate the Configuration to be migrated, on page 43
Review and verify the objects:
• Category
• Total ACL rules (Source Configuration)
• Total ACL rules considered for Optimization. For example, Redundant, Shadow, and so on.
• ACL Count for optimization gives the total number of ACL rules counted before and after Optimization.
If you have missed to download the Post-Migration Reports during migration, use the following link to
download:
Post-Migration Report Download Endpoint—http://localhost:8888/api/downloads/post_migration_summary_
html_format

Note

You can download the reports only when the Secure Firewall migration tool is running.

Procedure

Step 1

Navigate to where you downloaded the Post-Migration Report.

Step 2

Open the post-migration report and carefully review its contents to understand how your ASA configuration
was migrated:
• Migration Summary—A summary of the configuration that was successfully migrated from ASA to
threat defense, including information about the ASA interface, management center hostname and domain,
target threat defense device (if applicable), and the successfully migrated configuration elements.
• Selective Policy Migration—Details of the specific ASA feature selected for migration are available
within three categories - Device Configuration Features, Shared Configuration Features, and Optimization.
• ASA Interface to Threat Defense Interface Mapping—Details of the successfully migrated interfaces
and how you mapped the interfaces on the ASA configuration to the interfaces on the threat defense
device. Confirm that these mappings match your expectations.
Note

This section is not applicable for migrations without a destination threat defense device or if
Interfaces are not selected for migration.

• Source Interface Names to Threat Defense Security Zones and Interface Groups—Details of the
successfully migrated ASA logical interfaces and name and how you mapped them to security zones and
interface groups in threat defense. Confirm that these mappings match your expectations.
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Note

This section is not applicable if Access Control Lists and NAT are not selected for migration.

• Object Conflict Handling—Details of the ASA objects that were identified as having conflicts with
existing objects in management center. If the objects have the same name and configuration, the Secure
Firewall migration tool reused the management center object. If the objects have the same name but a
different configuration, you renamed those objects. Review these objects carefully and verify that the
conflicts were appropriately resolved.
• Access Control Rules, NAT, and Routes You Chose Not to Migrate—Details of the rules that you
choose not to migrate with the Secure Firewall migration tool. Review these rules that were disabled by
the Secure Firewall migration tool and were not migrated. Review these lines and verify that all the rules
you choose are listed in this section. If desired, you can configure these rules manually.
• Partially Migrated Configuration—Details of the ASA rules that were only partially migrated, including
rules with advanced options where the rule could be migrated without the advanced options. Review
these lines, verify whether the advanced options are supported in management center, and if so, configure
these options manually.
• Unsupported Configuration—Details of ASA configuration elements that were not migrated because
the Secure Firewall migration tool does not support migration of those features. Review these lines,
verify whether each feature is supported in threat defense. If so, configure those features manually in
management center.
• Expanded Access Control Policy Rules—Details of ASA access control policy rules that were expanded
from a single ASA Point rule into multiple threat defense rules during migration.
• Actions Taken on Access Control Rules
• Access Rules You Chose Not to Migrate—Details of the ASA access control rules that you choose
not to migrate with the Secure Firewall migration tool. Review these lines and verify that all the
rules you choose are listed in this section. If desired, you can configure these rules manually.
• Access Rules with Rule Action Change—Details of all Access Control Policy Rules that had ‘Rule
Action’ changed using the Secure Firewall migration tool. The Rule Action values are - Allow,
Trust, Monitor, Block, Block with reset. Review these lines and verify that all the rules you choose
are listed in this section. If desired, you can configure these rules manually.
• Access Control Rules that have IPS Policy and Variable Set Applied—Details of all ASA access
control policy rules that have IPS Policy applied. Review these rules carefully and determine whether
the feature is supported in threat defense.
• Access Control Rules that have File Policy Applied—Details of all ASA access control policy
rules that have File Policy applied. Review these rules carefully and determine whether the feature
is supported in threat defense.
• Access Control Rules that have Rule ‘Log’ Setting Change—Details of the ASA access control
rules that had ‘Log setting' changed using the Secure Firewall migration tool. The Log Setting values
are - False, Event Viewer, Syslog. Review these lines and verify that all the rules you choose are
listed in this section. If desired, you can configure these rules manually.
• Access Control Rules that have failed Zone-lookup—Details of the ASA access control rules
that fail the Route-lookup operation and that is populated in the Post-Migration Report. The Secure
Firewall migration tool performs the route-lookup operation based on the route (static and connected)
information in the source configuration to populate the destination security zones in the access rules.
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• Access Control Rules for Tunneled Protocols—Details of Tunnel rules that are migrated as a
prefilter tunnel rule during migration.
Note

An unsupported rule that was not migrated causes issues with unwanted traffic getting through your
firewall. We recommend that you configure a rule in management center to ensure that this traffic
is blocked by threat defense.

Note

If it requires you to apply IPS or file policy to ACL in the Review and Validate page, you are
highly recommended to create a policy on the management center before migration. Use the same
policy, as the Secure Firewall migration tool fetches the policy from the connected management
center. Creating a new policy and assigning it to multiple policies may degrade the performance
and may also result in a push failure.

For more information about supported features in management center and threat defense, see Management
Center Configuration Guide, Version 6.2.3.
Step 3

Open the Pre-Migration Report and make a note of any ASA configuration items that you must migrate
manually on the threat defense device.

Step 4

In management center, do the following:
a) Review the migrated configuration for the threat defense device to confirm that all expected rules and
other configuration items, including the following, were migrated:
• Access control lists (ACL)
• Network Address Translation rules
• Port and network objects
• Routes
• Interfaces
• IP SLA objects
• Object Group Search
• Time-based objects
• VPN objects
• Site-to-Site VPN Tunnels
• Dynamic Route objects
b) Configure all partially supported, unsupported, ignored, and disabled configuration items and rules that
were not migrated.
For information on how to configure these items and rules, see the Management Center Configuration
Guide. The following are examples of configuration items that require manual configuration:
• Platform settings, including SSH and HTTPS access, as described in Platform Settings for Threat
Defense
• Syslog settings, as described in Configure Syslog
• Dynamic routing, as described in Routing Overview for Threat Defense
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• Service policies, as described in FlexConfig Policies
• VPN configuration, as described in Threat Defense VPN
• Connection log settings, as described in Connection Logging
Step 5

After you have completed your review, deploy the migrated configuration from management center to the
threat defense device.
Verify that the data is reflected correctly in the Post-Migration Report for unsupported and partially supported
rules.
The Secure Firewall migration tool assigns the policies to the threat defense device. Verify that the changes
are reflected in the running configuration. To help you to identify the policies that are migrated, the description
of those policies includes the hostname of the ASA configuration.

Uninstall the Secure Firewall Migration Tool
All components are stored in the same folder as the Secure Firewall migration tool.
Procedure

Step 1

Navigate to the folder where you placed the Secure Firewall migration tool.

Step 2

If you want to save the logs, cut or copy and paste the log folder to a different location.

Step 3

If you want to save the pre-migration reports and the post-migration reports, cut or copy and paste the
resources folder to a different location.

Step 4

Delete the folder where you placed the Secure Firewall migration tool.
Tip

The log file is associated with the console window. As long as the console window for the Secure
Firewall migration tool is open, the log file and the folder cannot be deleted.

Sample Migration: ASA to Threat Defense 2100
Note

Create a test plan that you can run on the target device after you complete the migration.
• Pre-Maintenance Window Tasks
• Maintenance Window Tasks
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Pre-Maintenance Window Tasks
Before you begin
Make sure you have installed and deployed a management center. For more information, see the appropriate
Management Center Hardware Installation Guide and the appropriate Management Center Getting Started
Guide.
Procedure

Step 1

Use the show running-config command for the ASA device or context that you are migrating and save a
copy of the ASA configuration. See View the Running Configuration.
Alternately, use Adaptive Security Device Manager (ASDM) for the ASA device or context that you want to
migrate and choose File > Show Running Configuration in New Window to obtain the configuration file.
Note

For a multi context ASA, you can use the show tech-support command to obtain the configuration
for all the contexts in a single file.

Step 2

Review the ASA configuration file.

Step 3

Deploy the Firepower 2100 series device in your network, connect the interfaces and power on the appliance.
For more information, see Cisco Threat Defense for the 2100 Series Using Management Center Quick Start
Guide.

Step 4

Register the Firepower 2100 series device to be managed by the management center.
For more information, see Add Devices to the Management Center.

Step 5

(Optional) If your source ASA configuration has port channels, create port channels (EtherChannels) on the
target Firepower 2100 series device.
For more information, see Configure EtherChannels and Redundant Interfaces.

Step 6

Download and run the most recent version of the Secure Firewall migration tool from https://software.cisco.com/
download/home/286306503/type.
For more information, see Download the Secure Firewall Migration Tool from Cisco.com, on page 27.

Step 7

When you launch the Secure Firewall migration tool, and specify destination parameters, make sure that you
select the Firepower 2100 series device that you registered to the management center.
For more information, see Specify Destination Parameters for the Secure Firewall Migration Tool, on page
34.

Step 8

Map the ASA interfaces with the threat defense interfaces.
Note

The Secure Firewall migration tool allows you to map an ASA interface type to the threat defense
interface type.

For example, you can map a port channel in ASA to a physical interface in threat defense.
For more information, see Map ASA Configurations with Secure Firewall Device Manager Threat Defense
Interfaces.
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Step 9

While mapping logical interfaces to security zones, click Auto-Create to allow the Secure Firewall migration
tool to create new security zones. To use existing security zones, manually map the ASA logical interfaces
to the security zones.
For more information, see Map ASA Interfaces to Security Zones and Interface Groups.

Step 10

Follow the instructions of this guide to sequentially review and validate the configuration to be migrated, and
then push the configuration to the management center.

Step 11

Review the Post Migration report, manually setup and deploy other configurations to the threat defense and
complete the migration.
For more information, see Review the Post-Migration Report and Complete the Migration, on page 53.

Step 12

Test the Firepower 2100 series device using the test plan that you would have created while planning for
migration.

Maintenance Window Tasks
Before you begin
Make sure you have completed all the tasks that must be performed before the maintenance window. See
Pre-Maintenance Window Tasks, on page 57.
Procedure

Step 1

Connect to the ASA through the SSH console and switch to the interface configuration mode.

Step 2

Shutdown the ASA interfaces using the shutdown command.

Step 3

(Optional) Access the management center and configure dynamic routing for the Firepower 2100 series device.
For more information, see Dynamic Routing.

Step 4

Clear the Address Resolution Protocol (ARP) cache on the surrounding switching infrastructure.

Step 5

Perform basic ping tests from surrounding switching infrastructure to the Firepower 2100 series device interface
IP addresses, to make sure that they are accessible.

Step 6

Perform basic ping tests from devices which require layer 3 routing to Firepower 2100 series device interface
IP addresses.

Step 7

If you are assigning a new IP address to the Firepower 2100 series device and not reusing the IP address
assigned to the ASA device perform the following steps:
a. Update any static routes which refer to the IP address, so that they now point to the Firepower 2100 series
device IP address.
b. If you are using routing protocols, ensure that neighbors see the Firepower 2100 series device IP address
as the next hop for expected destinations.

Step 8

Run a comprehensive test plan and monitor logs within the managing management center for your Firepower
2100 device.
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Cisco Success Network-Telemetry Data
• Cisco Success Network-Telemetry Data, on page 59

Cisco Success Network-Telemetry Data
Whenever you initiate the migration process in the Secure Firewall migration tool, the corresponding telemetry
data file is stored at a fixed location. With Cisco Success Network enabled, when you push the migrated ASA
configuration to management center, the push service reads the telemetry data file from the location and deletes
it after the data is successfully uploaded to the cloud. If you log into the Secure Firewall migration tool using
the local credentials instead of your Cisco.com account credentials, the telemetry data will not be pushed to
the cloud and the data file is available here:
<migration_tool_folder>\resources \ telemetry_data
Following tables provide information on the telemetry data points, its description, and sample values.
Table 3: System Information

Data Point

Description

Example
Value

Operating
System

Operating system that runs the Secure Firewall migration tool. It could be Windows 7
Windows7/Windows10 64-bit/macOS High Sierra

Browser

Browser used to launch the Secure Firewall migration tool. It could be
Mozilla/5.0 or Chrome/68.0.3440.106 or Safari/537.36

Mozilla/5.0

Table 4: Source ASA Information

Data Point

Description

Example Value

Source Type

The source device type

ASA

Source Device Serial Number

Serial number of ASA

JAF1528ACAD

Source Device Model Number

Model number of ASA

ASA5585-SSP-10,
5969 MB RAM, CPU
Xeon 5500 series
2000 MHz, 1 CPU (4
cores)
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Data Point

Description

Example Value

Source Device Version

Version of ASA

9.(2)

Source Config Counts

The total number of lines in the source
configuration

504

Firewall Mode

The firewall mode configured on ASA - routed ROUTED
or transparent

Context Mode

The context mode of ASA. This can be single SINGLE
or multi-context.

ASA Config Statistics:
ACL Counts

The number of ACLs which are attached to
access group

46

Access Rules Counts

The total number of access rules

46

NAT Rule Counts

The total number of NAT rules

17

Network Object Counts

The number of network objects configured in 34
ASA

Network Object Group Counts

The number of network object groups in ASA 6

Port Object Counts

The number of port objects

85

Port Object Group Counts

The number of port object groups

37

Unsupported Access Rules Count

The total number of unsupported access rules 3

Unsupported NAT Rule Count

The total number of unsupported NAT access 0
rules

FQDN Based Access Rule Counts

The number of FQDN -based access rules

7

Time range Based Access Rule
Counts

The number of time range based access rules

1

SGT Based Access Rule Counts

The number of SGT-based access rules

0

Summary of Config lines that Tool is not able to parse
Unparsed Config Count

The number of config lines that are
unrecognized by the parser

Total Unparsed Access Rule Counts The total number of unparsed access rules

68
3

More ASA config details...
Is RA VPN Configured

Whether RA VPN is configured on ASA

false

Is S2S VPN Configured

Whether Site-to-Site VPN is configured on
ASA

false
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Data Point

Description

Example Value

Is BGP Configured

Whether BGP is configured on ASA

false

Is EIGRP Configured

Whether EIGRP is configured on ASA

false

Is OSPF Configured

Whether OSPF is configured on ASA

false

Local Users Counts

The number of local users configured

0

Table 5: Target Management Device (Management Center) Information

Data Point

Description

Example Value

Target Management Version The target version of management center

6.5 or later

Target Management Type

The type of target management device,
namely, management center

Management Center

Target Device Version

The version of target device

75

Target Device Model

The model of target device

Cisco Secure Firewall Threat
Defense for VMware

Migration Tool Version

The version of the migration too1

1.1.0.1912

Table 6: Migration Summary

Data Point

Description

Example
Value

Name

The name of access control policy

Doesn't Exist

Access Rule Counts

The total number of migrated ACL rules

0

Access Control Policy

Partially Migrated ACL Rule Counts The total number of partially migrated ACL rules 3
Expanded ACP Rule Counts

The number of expanded ACP rules

0

Name

The name of NAT policy

Doesn't Exist

NAT Rule Counts

The total number of migrated NAT rules

0

NAT Policy

Partially Migrated NAT Rule Counts The total number of partially migrated NAT rules 0
More migration details...
Interface Counts

The number of updated interfaces

0

Sub Interface Counts

The number of updated subinterfaces

0

Static Routes Counts

The number of static routes

0
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Data Point

Description

Example
Value

Objects Counts

The number of objects created

34

Object Group Counts

The number of object groups created

6

Interface Group Counts

The number of interface groups created

0

Security Zone Counts

The number of security zones created

3

Network Object Reused Counts

The number of objects reused

21

Network Object Rename Counts

The number of objects that are renamed

1

Port Object Reused Counts

The number of port objects that are reused

0

Port Object Rename Counts

The number of port objects that are renamed

0

Table 7: Secure Firewall Migration Tool Performance Data

Data Point

Description

Example
Value

Conversion Time The time taken to parse ASA configuration lines (in minutes)

14

Migration Time

592

The total time taken for end-to-end migration (in minutes)

Config Push Time The time taken to push the final configuration (in minutes)

7

Migration Status

The status of the migration of ASA configuration to management center SUCCESS

Error Message

The error message as displayed by the Secure Firewall migration tool

Error Description The description about the stage when the error has occurred and the
possible root cause

null
null

Telemetry ASA Example File
The following is an example of a telemetry data file on the migration of ASA configuration to threat defense:
{
"metadata": {
"contentType": "application/json",
"topic": "migrationtool.telemetry"
},
"payload": {
"asa_config_stats": {
"access_rules_counts": 46,
"acl_counts": 46,
"fqdn_based_access_rule_counts": 7,
"is_bgp_configured": false,
"is_eigrp_configured": false,
"is_multicast_configured": false,
"is_ospf_configured": false,
"is_pbr_configured": false,
"is_ra_vpn_configured": false,
"is_s2s_vpn_configured": false,
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"is_snmp_configured": false,
"local_users_counts": 0,
"nat_rule_counts": 17,
"network_object_counts": 34,
"network_object_group_counts": 6,
"port_object_counts": 85,
"port_object_group_counts": 37,
"sgt_based_access_rules_count": 0,
"timerange_based_access_rule_counts": 1,
"total_unparsed_access_rule_counts": 3,
"unparsed_config_count": 68,
"unsupported_access_rules_count": 3,
"unsupported_nat_rule_count": 0
},
"context_mode": "SINGLE",
"error_description": null,
"error_message": null,
"firewall_mode": "ROUTED",
"migration_status": "SUCCESS",
"migration_summary": {
"access_control_policy": [
[
{
"access_rule_counts": 0,
"expanded_acp_rule_counts": 0,
"name": "Doesn't Exist",
"partially_migrated_acl_rule_counts": 3
}
]
],
"interface_counts": 0,
"interface_group_counts": 0,
"nat_Policy": [
[
{
"NAT_rule_counts": 0,
"name": "Doesn't Exist",
"partially_migrated_nat_rule_counts": 0
}
]
],
"network_object_rename_counts": 1,
"network_object_reused_counts": 21,
"object_group_counts": 6,
"objects_counts": 34,
"port_object_rename_counts": 0,
"port_object_reused_counts": 0,
"security_zone_counts": 3,
"static_routes_counts": 0,
"sub_interface_counts": 0
},
"migration_tool_version": "1.1.0.1912",
"source_config_counts": 504,
"source_device_model_number": "
ASA5585-SSP-10, 5969 MB RAM, CPU Xeon 5500 series
2000 MHz, 1 CPU (4 cores)",
"source_device_serial_number": "JAF1528ACAD",
"source_device_version": "9.6(2)",
"source_type": "ASA",
"system_information": {
"browser": "Chrome/69.0.3497.100",
"operating_system": "Windows NT 10.0; Win64; x64"
},
"target_device_model": "Cisco Firepower Threat Defense for VMWare",
"target_device_version": "75",
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"target_management_type": "Management Center",
"target_management_version": "6.2.3.3 (build 76)",
"time": "2018-09-28 18:17:56",
"tool_performance": {
"config_push_time": 7,
"conversion_time": 14,
"migration_time": 592
}
},
"version": "1.0"
}
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Troubleshooting Migration Issues
• About Troubleshooting for the Secure Firewall Migration Tool, on page 65
• Logs and Other Files Used for Troubleshooting, on page 66
• Troubleshooting ASA File Upload Failures, on page 66

About Troubleshooting for the Secure Firewall Migration Tool
A migration typically fails during the ASA configuration file upload or during the push of the migrated
configuration to management center.
Some of the common scenarios where the migration process fails are:
• Unknown or invalid characters in the ASA configuration file
• Incomplete or missing elements in the ASA configuration file
• Loss of network connectivity or latency
Secure Firewall Migration Tool Support Bundle
The Secure Firewall migration tool provides the option to download a support bundle to extract valuable
troubleshooting information like log files, DB, and configuration files. Perform the following:
1. On the Complete Migration screen, click the Support button.
The Help support page appears.
2. Check the Support Bundle check box and then select the configuration files to download.

Note

The Log and dB files are selected for download by default.

3. Click Download.
The support bundle file is downloaded as a .zip to your local path. Extract the Zip folder to view the log
files, DB, and the Configuration files.
4. Click Email us to email the failure details for the technical team.
You can also attach the downloaded support files to your email.
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5. Click Visit TAC page to create a TAC case in the Cisco support page.

Note

You can open a TAC case at any time during the migration from the support page.

Logs and Other Files Used for Troubleshooting
You can find information that is useful for identifying and troubleshooting issues in the following files.
File

Location

Log file

<migration_tool_folder>\logs

Pre-migration report

<migration_tool_folder>\resources

Post-migration report

<migration_tool_folder>\resources

unparsed file

<migration_tool_folder>\resources

telemetry_sessionid_timestamp.json

<migration_tool_folder>\resources\telemetry_data

Troubleshooting ASA File Upload Failures
If your ASA configuration file fails to upload, the reason is typically because the Secure Firewall migration
tool could not parse one or more lines in the file.
You can find information about the errors that caused the upload and parsing failure in the following locations:
• Error message displayed by the Secure Firewall migration tool—Provides a high-level summary of what
caused the failure.
• Log file—Search on the word "error" to view the reason for the failure.

Troubleshooting Example for ASA: Cannot Find Member of Object Group
In this example, the ASA configuration file upload and parsing that is failed because the parser could not find
one of the members of an object group.
Procedure

Step 1

Review the error messages to identify the problem.
This failure generated the following error messages:
Location

Error Message

Migration Tool message

N/A
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Location

Error Message

Configuration Lines with Errors
section of the pre-migration report

Line#2[ERROR] group-object GROUP1
Line#3[ERROR] group-object GROUP2
Line#1[ERROR] object-group network NOV-SERVERS

Log file

[INFO | object_group_mode.py:9491 > Parsing object-group network:
[NOV-SERVERS]
[ERROR | object_group_mode.py:1048 ] [GROUP1] group not found
when creating object-group network [NOV-SERVERS]
[ERROR | object_group_mode.py:1049 ] no row was found for one()
[ERROR | object_group_mode.py:1048 ] [GROUP2] group not found
when creating object-group network [NOV-SERVERS]
[ERROR | object_group_mode.py:1049 ] no row was found for one()

Step 2

Open the ASA configuration file and do the following:
a) Search for the object group by name: NOV-SERVERS
The ASA configuration file shows the following lines for NOV-SERVERS:
object-group network NOV-SERVERS
group-object GROUP1
group-object GROUP2

b) Search for each member of the group to identify which member is not included in the ASA configuration
file.
Step 3

To resolve the error, do the following using ASDM on the source ASA device:
a) Create the missing member for the object group.
b) Export the configuration file.

Step 4

If there are no more errors, upload the new ASA configuration file to the Secure Firewall migration tool and
continue with the migration.

Troubleshooting Example for ASA: List Index Out of Range
In this example, the ASA configuration file upload and parsing that is failed because of an error in the
configuration of an element that the Secure Firewall migration tool does not support.
Procedure

Step 1

Review the error messages to identify the problem.
This failure generated the following error messages:
Location

Error Message

Migration Tool message

list index out of range
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Step 2

Location

Error Message

Configuration Lines with Errors
section of the pre-migration report

N/A

Log file

[ERROR | asa_config_upload.py:119] > list index out of range

Open the unparsed file and scroll to the bottom to identify the last line of the ASA configuration file that was
successfully parsed.
In this example, the last line in the unparsed file is the following:
Line#345 [SKIPPED] address 209.165.200.224 255.255.255.224

Step 3

Open the ASA configuration file and do the following:
a) Search for address 209.165.200.224 255.255.255.224
The line that follows this one contains the configuration element that caused the issue.
b) Review the line to determine what is causing the migration to fail.
In this example, the line where the Secure Firewall migration tool had stopped parsing is name
www.example.s3.amazonaws.com. This is the line in the ASA configuration file that is directly after the
last line in the unparsed file. If you cannot identify the issue with this line, we recommend that you review
the Known Issues section in the Release Notes for the Secure Firewall Migration Tool to see if you have
encountered one of the known issues in the release.
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Secure Firewall Migration Tool FAQs
• Secure Firewall Migration Tool Frequently Asked Questions, on page 69

Secure Firewall Migration Tool Frequently Asked Questions
Q. What are the new features supported on the Secure Secure Firewall migration tool for Release 3.0.1?
A. The following features are supported with release 3.0.1:
• Migration of Enhanced Interior Gateway Routing Protocol (EIGRP) from ASA.
• Secure Firewall 3100 series is supported as a source or destination device for ASA migrations.
Q. What are the new features supported on the Secure Secure Firewall migration tool for Release 3.0?
A. The following features are supported with release 3.0:
• Remote Access VPN migration
• Migration to Cloud-delivered Firewall Management Center
Q. What are the new features supported on the Secure Secure Firewall migration tool for Release 2.5.1?
A. The following features are supported with release 2.5.1:
• Dynamic Route objects
• Border Gateway Protocol
Q. What are the new features supported on the Secure Secure Firewall migration tool for Release 2.5?
A. The following features are supported with release 2.5:
• ACL Optimization
• Wildcard mask
Q. What are the new features supported on the Secure Secure Firewall migration tool for Release 2.4?
A. The following ASA VPN configuration migration to threat defense:
• Crypto map (static/dynamic) based VPN from ASA
• Route-based (VTI) ASA VPN
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• Certificate-based VPN migration from ASA
Q. What are the new features supported on the Secure Secure Firewall migration tool for Release 2.3.5?
A. The following features are supported with release 2.3.5:
• Virtual Tunnel Interface (VTI) and related configurations in Static routes, ACL.
• Route-based (VTI) VPN tunnels
Q. What are the new features supported on the Secure Secure Firewall migration tool for Release 2.3.4?
A. The following features are supported with release 2.3.4:
• VPN Objects
• Site-to-Site VPN Tunnels
Q. What are the source and target platforms that the Secure Secure Firewall migration tool can migrate
policy?
A. The Secure Secure Firewall migration tool can migrate policies from supported ASA platform to threat
defense platform. For more information, see Supported Source ASA Platforms, on page 18.
Q. What are the tasks that you must perform in the Pre-Migration and Post-Migration Reports?
A. To perform the tasks as part of your plan for migrating from ASA to Firewall Threat Defense, see Sample
Migration: ASA to Threat Defense 2100 .
Q. What are the supported destination platforms versions?
A. You can use the Secure Firewall migration tool to migrate an ASA configuration to the standalone or
container instance of the Firewall Threat Defense platforms for management center 6.2.3 or later. For
more information on the list of supported devices, see Supported Target Threat Defense Platforms, on
page 19.
Q. What are the features the Secure Firewall migration tool supports for migration?
A. The Secure Firewall migration tool supports migration of L3/L4 ASA configuration to threat defense. It
also allows enabling L7 features like IPS, file policy, and so on, during the migration process.
The Secure Firewall migration tool can fully migrate the following ASA configurations:
• Network objects and groups (except discontiguous masks)
• Service objects, except for those service objects configured for a source and destination

Note

Though the Secure Firewall migration tool does not migrate extended service
objects (configured for a source and destination), referenced ACL and NAT
rules are migrated with full functionality.
• Service object groups, except for nested service object groups,VPN objects, and ASA crypto map
VPN migration

Note

Since nesting is not supported on the management center, the Secure Firewall
migration tool expands the content of the referenced rules. The rules,
however, are migrated with full functionality.
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• IPv4 and IPv6 FQDN objects and groups
• IPv6 conversion support (Interface, Static Routes, Objects, ACL, and NAT)
• Access rules that are applied to interfaces in the inbound direction and global ACL
• Auto NAT, Manual NAT, and object NAT (conditional)
• Static routes, except for those configured with the track option which are partially migrated and
ECMP routes which are not migrated
• Physical interfaces
• Subinterfaces
• Port channels
• Bridge groups (transparent mode only)
• Tunneling protocol-based access control policy rules (migrated as Prefilter tunnel rules)
• Category-based rule for CSM managed configurations
• IP SLA Monitor
• Object Group Search
• Time-based Objects
• VPN objects
• VTI interfaces
• Policy-based (Crypto Map) and Route-based (VTI) VPN tunnels
• Certificate-based VPN migration from ASA to threat defense
• Dynamic Route objects for EIGRP and BGP
• Remote Access VPN
Q. What are the new features supported on the Secure Firewall migration tool for Release 2.2?
A. The following features are supported with release 2.2:
• Object Group Search
• IP SLA Monitor
• Time-based Objects
Q. What are the new features supported on the Secure Firewall migration tool for Release 2.0?
A. The following features are supported with release 2.0:
• Destination Zone mapping for Access Rules
• Prefilter tunnel rules
• Category-based rules
• Policy Limit and Capacity Warning

Migrating Secure Firewall ASA to Threat Defense with the Migration Tool
71

Secure Firewall Migration Tool FAQs
Secure Firewall Migration Tool Frequently Asked Questions

• ASA 5505 and ASA-SM migration support
Q. Is there any dependency on management center to use the new features introduced in the Secure Firewall
migration tool?
A. Yes. The following features are supported with target management center 6.5 and later:
• Migrate tunnel Rules as Prefilter
• Category-based rules
• ASA 5505 Migration

Note

Requires management centerversion 6.5 and later to migrate to target threat
defense FPR-1010 platform.

The following features are supported with target management center 6.6 and later:
• Object Group Search
• IP SLA Monitor
• Time-based Objects
• VPN Objects
• Site-to-Site VPN Tunnels
The following features are supported with target management center 6.7 and later:
• VTI interface and the related static routes.
• Route-based (VTI) Pre-Shared Key authentication type VPN configuration to management center.
• Create routed security zone, add VTI interfaces, and then define access control rules for the decrypted
traffic control over VTI tunnel.
The following features are supported with target management center 7.1 and later:
• Dynamic Route objects
• BGP
The following features are supported with target management center 7.2 and later:
• Remote Access VPN
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• EIGRP
Q. Can we migrate all the access rules in the source configuration to the Prefilter policy?
A. No. For migrations that are opted with Migrate Tunnel rules as Prefilter, the Secure Firewall migration
tool identifies tunneling protocol-based access rules and migrates them as tunnel rules.
Q. What are the features the Secure Firewall migration tool does not migrate today?
A. The Secure Firewall migration tool does not support the following ASA configurations for migration. If
these configurations are supported in management center, you can configure them manually after the
migration is complete.
• SGT-based access control policy rules
• SGT-based objects
• User-based access control policy rules
• NAT rules that are configured with the block allocation option
• Objects with unsupported ICMP type and code
• Tunneling protocol-based access control policy rules
• NAT rules that are configured with SCTP
• NAT rules that are configured with host ‘0.0.0.0’
• Tunneling protocol-based access control policy rules (supported from Secure Firewall migration
tool 2.0 with target management center 6.5 and later)
• Dynamic Crypto map based VPN
• Certificate authentication based VPN configuration
For more information, see Guidelines and Limitations, on page 14.
Q. What are the supported source devices and code version?
A. You can use the Secure Firewall migration tool to migrate the configuration from single or multi-context
ASA platforms (software version 8.4 or later). For more information on the list of devices, see Supported
Source ASA Platforms, on page 18.
Q. Does the Secure Firewall migration tool support migration of multi-context ASA?
A. Yes. The Secure Firewall migration tool can handle migration of multi-context ASA. At any given point
in time, one can migrate one context of the ASA (except for System context) to either threat defense
container or native instances on the target management center.
Q. What is the support mechanism if there are migration errors?
A. The Secure Firewall migration tool is integrated with Cisco Success Network. If there are errors or issues,
contact Cisco TAC. For troubleshooting, see Troubleshooting Migration Issues, on page 65.
Q. How much time does the Secure Firewall migration tool take to successfully migrate a configuration?
A. The time that is taken during migration depends on numerous factors like latency on network, load on
the management center, config size, number of objects, ACL, and so on. In internal testing, it was observed
that a config file of 2.0 MB with 7000+ Access Control List, 7000+ NAT Translations, and 3000+
Network Objects takes around 6 minutes to successfully complete the migration.
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